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About Dell Repository Manager
Dell Repository Manager (DRM) is an application within the Dell OpenManage portfolio that allows IT administrators to manage
the system updates. Dell Repository Manager provides you with the updates from the Dell inventory and catalogs that are
available in the application preferences.

DRM ensures that the systems are up to date with the latest BIOS, drivers, and firmware. DRM allows you to:

● Compare the Dell inventory with the catalogs to provide updates on the Dell systems.
● Create repositories using the base catalog and specify the Dell system whose components are added in the repository.
● Rearrange the components to group the related updates together for systems running the Microsoft Windows and Linux

operating systems.
● Generate comparison reports and update baselines of the custom repositories.
● Import the repository content in .exe, .msi, and .bin formats.
● Export the repository content in catalog.xml format only.

The customized repositories consist of Dell Update Packages (DUPs) or Non-DUPs with formats-.exe, .msi, .bin, or any other
file formats-files. Use the repositories to apply updates with the update packages. DUPs are software utilities that are provided
to update specific software and firmware components.

Dell Repository Manager integrates with Dell systems management products such as iDRAC, Dell OpenManage Enterprise, Dell
OpenManage Essentials and the Dell Management Plug-in for VMware vCenter.

Topics:

• New features

New features
Table 1. New features in Dell Repository Manager v3.4.4 

Functional area Feature description Summary of benefits

Protocols Supported protocols Support for Redfish protocols.

Schedule export jobs Support to schedule the
export jobs

Support to schedule the export jobs for any
interval (daily, weekly, or monthly).

Delete Catalog using CLI mode Delete a catalog using CLI
mode

Support to delete a catalog using CLI mode

Repository with Integration The default selection of
DUP formats for the
selected integration type.

● If any DUP format (Linux, Windows-64,
and OS-Independent) is not selected,
then based on the Integration type you
select, the applicable DUP formats are
selected automatically.

● The default selection of DUP formats is
enabled for modification.

Command line Interface (CLI) mode Extended support for CLI
mode

Enhanced CLI to accept only the supported
commands for any DRM operations. Any
partial or incomplete commands are not
supported.

Platform bootable ISO plug-in Enhanced support for
Platform bootable ISO
plug-in

Support enabled for Platform bootable ISO
plug-in (SLES operating system Kernel
based) for DRM version 3.4.4 or later.

Dell System Update (DSU) support Support for DSU Support for DSU latest version.

Security Security enhancements Enhanced the security aspects.
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Compatibility Matrix
This chapter addresses the language, hardware and software requirements to be considered before installing DRM.

Topics:

• Language requirement
• Minimum hardware requirements
• Software requirements
• Optional requirements

Language requirement
DRM supports English US. No locale formats or other languages are supported.

Minimum hardware requirements
Table 2. Hardware requirements 

Requirement Details

Processor 1 GHz Pentium processor or equivalent

RAM 4 GB

Hard Disk 1 GB of available space

Display 1024x768–2560x1600 (maximum) high color, 64-bit

Optical Drive (Optional) CD/DVD writer

Architecture or Platforms for laptops x86

Software requirements
DRM works on a wide range of Operating Systems for Windows and Linux. Listed are the specific Operating Systems that DRM
is tested with:
● Microsoft Windows Server 2019
● Microsoft Windows Server 2022
● Microsoft Windows 10
● Microsoft Windows 11
● RedHat Enterprise Linux 8.8
● RedHat Enterprise Linux 9.2
● SUSE Linux 15 SP5
● Ubuntu 22.04

Optional requirements
● Internet connectivity—To access, create, work with bundles, update catalogs, plug-ins, and repositories.

NOTE: You can use the local repositories on DRM without internet connectivity.

● CD/DVD or USB burning software—To create a bootable CD/DVD or bootable USB.
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Getting started with DRM
This chapter describes the process to download DRM application on windows operating systems and linux operating systems
and the access privileges required to install DRM on windows operating systems.

Topics:

• Download DRM
• Access privileges for installing DRM on Microsoft Windows operating systems

Download DRM
You can download DRM from DRM Knowledge Base page or dell.com/support.

To download DRM from dell.com/support:

1. Launch the Dell support site.
2. Enter Dell Repository Manager in the search box and press Enter.
3. In Dell Repository Manager resources, click DRM Download link. The Dell Repository Manager driver details page is

displayed.
4. From the Available formats section, click Download to download the .exe file and .bin files.

The DRM installer is downloaded in the local drive.

Access privileges for installing DRM on Microsoft
Windows operating systems
Install DRM with specific access privileges to run the DRM services on windows operating systems.

The access privileges are:

● Restricted Access—The DRM service runs with LocalService account privileges. The restricted access is selected by
default when installing DRM in GUI mode or CLI mode. For any directories that are required to be accessed from DRM, the
user must manually provide access to the DRM service. For example, an explicit access must be granted to files and folders
for any DRM operations to be performed.

NOTE:

○ DRM v3.4.3 or later version can be installed with default-restricted access privileges in silent mode.

○ If the restricted access mode is selected, the recommendation is to disable the privilege SeImpersonatePrivilege in

your system to enhance the security protocols.

● System Access—The DRM service runs with LocalSystem account privileges. Unlike restricted access, installing DRM
with system access does not require access to DRM services for the operating system or Local directories. For example, an
explicit access to files and folders is not required for any DRM operation to be performed.

NOTE: If you select system access to run the DRM services, certain operating system directories are not accessible for

any operations through DRM. The directories include Program Files, Program Files(x86), and Windows.
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Install DRM
Install the DRM application on windows and linux operating systems using Graphical user interface (GUI), command line
interface in interactive or console mode, and silent mode.

Dell Repository Manager creates a database in the system during the installation process.

For the list of supported operating systems, see Software requirements.

For the supported languages, see Language requirement.

For more information about using DRM with Command line interface (CLI), see Appendix A.

Topics:

• Install DRM using GUI on Windows operating systems
• Install DRM using CLI on Windows operating systems
• Install DRM using silent mode on Windows operating system
• Install DRM on Linux operating systems
• Install DRM using silent mode on Linux operating systems
• Sample commands
• Launch Dell Repository Manager

Install DRM using GUI on Windows operating systems
Install the DRM using a graphical user interface (GUI) on Microsoft Windows operating systems to manage the system updates.

About this task

The cleanup of the installation directory is performed before installing DRM. Ensure that you take a backup of installation logs
before upgrading DRM.

Steps

1. Download the DRM installer .exe file from the Dell support site.

2. Go to the location where the DRM installer is downloaded. Double-click <DRMINSTALLER_3. x.x.xxx_A00 > , where x.x.xxx
denotes the latest version or the build number.
The Dell Repository Manager installation wizard is displayed.

NOTE: The preinstallation summary on DRM installer GUI does not appear in a readable format during a fresh installation

of DRM on a Windows operating system with a resolution less than 1600.

3. Review the Introduction page and click Next.

4. Review the License Agreement and select I accept the terms of the License Agreement, and click Next.

Click Previous to review the selected preferences on the previous page.

5. On the Choose Install Folder page, select a folder and click Next.

To revert to the default folder, click Restore Default Folder.
NOTE: If an installation directory or the working directory path C:\programdata\dell\drm contains the symbolic

links, then the installation is stopped because symbolic links can lead to a security breach. Remove the symbolic link and

retry the installation.

6. On the Choose Shortcut Folder page, select one of the locations and click Next. The available options are In a new
Program Group, In the Start Menu, On the Desktop, In the Quick Launch Bar, Other, and Don’t create icons.

If you want to create icons for all the users using the repository manager, select Create Icons for All Users.

NOTE: An intermittent performance lag is observed when you switch between the create shortcut options multiple

times using keyboard during the fresh installation of DRM.
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7. On the Migrate previous versions data page, the Repositories information and Preferences from any 2.x version of the
repository manager (if installed) is migrated to the current version of the software.

8. On the Database page, Set DRM database password by entering the Password and then Confirm Password.
NOTE:

● DRM database password must contain a minimum of eight characters with a combination of one uppercase, one

lowercase, and one numeric character.

● Only admin users can update the database password by using the update password command.

● The use of special characters in database password is not mandatory.

● If the password is lost, DRM cannot recover it.

9. On the Service page, select Restricted access or System Access. For more information, see Access privileges.
NOTE: The Restricted access is selected by default when you install DRM using GUI or CLI mode. If needed, change

the access privilege from restricted to system access, or system to restricted access while upgrading from DRM v3.4.3

to any above versions. For more information about changing the access without losing data, see the Frequently asked

questions section.

10. On the Pre-Installation Summary page, review the selected preferences and click Install.

11. On the Progress page, view the progress of DRM installation.
The installation is completed in a few minutes. The DRM application icon is created on the desktop.

12. On the Install status page, click Done to exit the installer.
Dell repository manager is configured on your system.

13. When the Service Installation Successful message is displayed, click Ok.

Results

DRM services start in a few minutes.

View the status of the DRM services in Task Manager > Services > DRM services > Running.

Install DRM using CLI on Windows operating systems
Install DRM using a command-line interface (CLI) in an interactive or console mode and silent mode on Windows operating
systems to manage the system updates. The silent mode does not need a password and installs DRM in the default path.

About this task

The restricted access is selected by default when you install DRM using GUI or CLI mode. If needed, change the access privilege
from restricted to system access, or system to restricted access while upgrading from DRM v3.4.3 to above versions.

For more information about access privileges, see Access privileges for installing DRM on Microsoft Windows operating systems.
NOTE: The cleanup of the installation directory is performed before installing DRM. Ensure that you take a backup of

installation logs before upgrading DRM.

Steps

1. Download the <DRMINSTALLER_3.x.x.xxx_A00> software from the support site dell.com/support.

2. Launch the command prompt or the command-line interface (CLI) from the folder location where the DRM installer file is
available.

3. On the interface, enter one of the following commands and press Enter.
● For CLI mode:DRMInstaller_3.x.x.x_A00.exe -i console
● Or
● For GUI mode: DRMInstaller_3.x.x.x_A00.exe

4. Review the Introduction and press Enter to continue.

5. Review the license agreement and then accept by entering Y or N > Enter.

6. Select the default folder location or enter an absolute path to install DRM and press Enter.

NOTE: If an installation directory or the working directory path C:\programdata\dell\drm contains the symbolic

links, then the installation is stopped because symbolic links can lead to a security breach. Remove the symbolic link and

retry the installation.
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7. Enter Y (yes) to verify the DRM installer location and press Enter.

8. Select the location to create the DRM application link and press Enter to accept the default location.

If you install DRM to a default location, ensure that the installed DRM and its features work as expected.

9. Set the DRM database password by entering the Password and press Enter.

● DRM database password must contain a minimum of eight characters with a combination of one uppercase, one
lowercase, and one numeric character.

● The use of special characters in database password is not compulsory.
● If the password is lost, DRM cannot recover the last set password.
● Only an admin user can update the database password by using update password command.

10. Enter the password again to Confirm Password, and press Enter. Review the Pre-Installation summary, and press
Enter to continue.

11. Press Enter to install DRM.
When the Installation completes in a few minutes, press Enter to exit the Installer.

Results

● DRM application shortcut icon is created on the desktop.
● To view the installed files, go to Program files > Dell > Dell Repository Manager.
● Launch DRM and click Alerts to view the status as Services started.

Next steps

Post-installation:
1. After the installation is completed, a drmuser user account is created. This account is used to run all DRM tasks in

repositories and catalogs.
2. Provide read and write access to a drmuser user account for all directories and files that are used for repository and catalog

tasks.
NOTE: If the drmuser user account does not have the required read and write access to the respective directories and

files that are used for repository and catalog tasks, this gives an Access Denied error.

Install DRM using silent mode on Windows operating
system
The installation of DRM application using silent mode does not require a password and installs DRM in the default path.

About this task

The cleanup of the installation directory is performed before installing DRM. Ensure that you take a backup of installation logs
before upgrading DRM.

Steps

1. Launch the command prompt or the command line interface (CLI) from the folder location where the DRM Installer file is
available.

2. Enter the command: DRMInstaller_3.x.x.x_A00.exe -i silent.

3. Press Enter.

The Database password option to set and update the password is not enabled for silent mode.

The silent mode installation installs the DRM application in the default path.
NOTE: If an installation directory or the working directory path C:\programdata\dell\drm contains the symbolic

links, then the installation is stopped because symbolic links can lead to a security breach. Remove the symbolic link and

retry the installation.

Results

● DRM application shortcut icon is created on the desktop.
● To view the installed files, go to Program files > Dell > Dell Repository Manager.
● Launch DRM and click Alerts to view the status as Services started.
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Install DRM on Linux operating systems
Install DRM using GUI mode, CLI interactive or console mode, and silent mode on Linux operating systems to manage the system
updates.

Prerequisites

● Log in with the root or administrative privileges.
● Install the following libraries for Ubuntu operating systems:

○ Libgtk-2.0-0
○ Libgtk-2.0-cil

Steps

1. Download the <DRMINSTALLER_3.x.x.xxx_A00> software from the support site dell.com/support.

2. Launch the command prompt or command-line interface and go to the location where the DRM installer file is available.

NOTE: The preinstallation summary on DRM installer GUI does not appear in a readable format using GUI mode during

the fresh installation of DRM having resolution less than 1600.

3. On the interface, enter one of the following commands:
● For CLI mode: DRMInstaller_3.x.x.x_A00.bin -i console

Or

● For GUI mode: DRMInstaller_3.x.x.x_A00.bin
4. Review the Introduction and press Enter to continue.

5. Review the license agreement, enter (0) and then accept by entering Y or N > Enter.

6. Select the default folder location to install and create the DRM application link and then press Enter. Or press Enter to
accept the default location.

NOTE: Any custom path location is not supported on the Linux operating system.

7. Set the DRM database password by entering the Password and press Enter.

● DRM database password must contain a minimum of eight characters with a combination of one uppercase, one
lowercase, and one numeric character.

● The use of special characters in database password is not compulsory.
● If the password is lost, DRM cannot recover the last set password.
● Only a root user can update the database password by using update password command.

8. Review the Pre-Installation summary, and press Enter to continue.

9. The default location to install DRM is /opt/dell/dellrepositorymanager/. Press Enter.

10. In jre folder deletion check, press Enter.
The Installation completes in a few minutes. Press Enter to exit the Installer and press Enter again.

Next steps

Post-installation:
1. After the installation is completed, a drmuser user account is created. This account is used to run all DRM tasks in

repositories and catalogs.
2. Provide read and write access to a drmuser user account for all directories and files that are used for repository and catalog

tasks.
NOTE: If the drmuser user account does not have the required read and write access to the respective directories and

files that are used for repository and catalog tasks, gives an Access Denied error .
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Install DRM using silent mode on Linux operating
systems
The installation of DRM application using silent mode on linux operating systems does not need password and installs DRM in the
default path.

Steps

1. Launch the command prompt or the command line interface (CLI) from the folder location where DRM Installer file is
available.

2. Enter the command: ./DRMInstaller_3.x.x.x_A00.bin -i silent.

3. Press Enter.
Wait for a few minutes for DRM to install. The silent mode installation installs the DRM application in the default path.

NOTE: The Database password option to set and update the password is not needed for silent mode.

Results

● DRM application shortcut icon is created on the desktop.
● To view the installed files, enter a path opt/dell/dellrepositorymanager/ and press Enter.

● To view the downloaded files, enter ls and press Enter.

Sample commands
This section describes some of the sample commands that are used in installing and using DRM.

Table 3. Sample commands 

Linux syntax Microsoft Windows syntax Description

/DRMInstaller.bin DRMInstaller.exe The DRM installer is opened only if the
operating system supports a GUI. If
the operating system does not support
a GUI then the installation proceeds
without the GUI.

./drm –h or ./drm –-help drm /? or drm /h Displays the command line options and
help information.

./drm –v or ./drm --version drm /v or drm –version Displays the installed DRM version.

Change Dell Repository
Manager Installation.sh -i
silent -uninstall

Change Dell Repository Manager
Installation.exe -i silent
-uninstall

Uninstall DRM silently, and the DRM
data is removed by default without
user intervention.

Change\ Dell\ Repository\
Manager\ Installation -i
console -repair

Change Dell Repository Manager
Installation.exe" -i console
-repair

Repair DRM

Launch Dell Repository Manager
Launch Dell Repository Manager (DRM) from the desktop, or from the Start menu, or go to the folder location where DRM is
installed. By default, DRM is installed in C:\Program Files\Dell\Dell Repository Manager\drm.bat.

To run DRM on Linux operating system—Type drm on the black terminal console.

To run DRM from the Start menu—Click Start > All programs > Dell Repository Manager.

To run DRM using desktop—Click Dell Repository Manager application icon available on desktop.

To run DRM using command line interface—Open the command prompt and type drm.
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Configure Application Preferences
This chapter provides instructions to configure the application preferences to use the DRM application. Configure the various
settings such as network, notifications, plug-in update, catalog update, and data storage settings.

Topics:

• Configure network settings
• Configure notifications
• Configure store settings
• Configure plug-in settings
• Configure catalogs settings
• Configure DRM to use SUU as a content source

Configure network settings
Configure the network settings that define the preferences that are used when performing any activity involving or requiring
network connectivity.

Steps

1. Click Dell Repository Manager > Application Preferences.
The Preferences window is displayed.

2. In the left pane, click Network to configure the following settings:

● Web Download Protocol—Only the HTTPS protocol is supported to download content from the Dell support site.
● (Optional) Concurrent downloads—Set the number of downloads with a maximum limit of 10 DUPs at a time. Go to

Dell Repository Manager > View > Jobs to view the status of the download.
● Proxy configuration—If you require a proxy server, enable the Proxy server tab.

○ Enter the Proxy Server Address and Proxy Port.
○ Click Credentials to provide the username and password.

NOTE: When setting the proxy in CLI, ensure that you provide a proxy port number.

Table 4. Port information 

Port numbers Protocols and file sharing

8090 DRM Service

443 HTTPS

80 HTTP through proxy server

137-139 and 445 CIFS and SMB

NOTE:

● The NFS share is not supported.

● If the proxy server is enabled, the following features that use the downloads from the support site are supported

with the proxy server: Download, Export, Platform Bootable ISO, Catalog update, and Plug-in update.

3. Click Apply.
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Configure notifications
Configure the notifications to notify the users about any updates that are related to jobs, catalogs, or refresh.

Steps

1. Click Dell Repository Manager > Application Preferences.
The Preferences window is displayed.

2. In the left pane, click Notification, select the relevant option—Notification for Catalog update or Notification for jobs
and provide the email IDs.

Add more email addresses to notify multiple users. To add multiple users, separate the recipients using a semicolon (;).

3. Click Configure in the upper right corner.
The Configure Email window is displayed.

4. From the Email Type drop-down menu, select the method through which you want to send an email. The available options
are SMTP and Microsoft Exchange.

If you select SMTP, provide the following details:
● In Sender details:

○ If you enable the anonymous authentication, enter an email ID of the recipient.
○ If you disable, enter an email ID, username, password, and domain.

● In SMTP options:
○ Enter the SMTP server and port number.
○ To bypass proxy, select None.
○ To establish communication, select SSL or TLS.

NOTE: It is recommended to have the message size in mail server that is configured to a minimum of 25 MB to

ensure proper functioning of notification.

If you select Microsoft Exchange, enter an email ID, username, password, and Microsoft Exchange URL.

5. Click Send Test Mail.
The Test Mail successful message is displayed in the lower left corner.

6. Click Reset and Save > Save > Apply > Ok.

Results

NOTE: A notification is sent to the email address that has been configured.

Configure store settings
Configure the storage settings to store the repository information, downloaded files, or logs.

Prerequisites

● If you install or upgrade DRM 3.4.3 or later with restricted access mode on Windows operating system, ensure that you
have required access—(read or write, list folder contents, so on) to the NT AUTHORITY\LOCAL SERVICE account in the
directory including all sublevel directories. This access is required to export, import, download a repository, add a catalog,
update a plug-in, or configure the storage location in Dell Repository Manager > Application Preferences.

● For Linux users only, ensure that you have read and write access to the drmuser account in the particular directory including
all subdirectories. This access is required to export, import, or download a repository, add a catalog, update a plug-in, or
configure the storage location in Dell Repository Manager > Application Preferences.

Steps

1. Click Dell Repository Manager > Application Preferences.
The Preferences window is displayed.

2. In the left pane, click Store.

3. Click Browse to select the location to store the repositories and click Open.

NOTE:

● The default location for storage is C:\ProgramData\Dell\drm\store.
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● The Browse text box field is disabled to edit the store path.

4. In the Alert when storage exceeds, enter a value less than from the storage space available. The maximum storage
space available is 406.11 GB.

NOTE: When the size of the file exceeds a certain limit (less than the maximum size), an alert is sent.

5. Click Clean Up to clear the files after deleting any repositories, or DUPs or bundles or any components that are not
referenced.

6. When the Cleanup job submitted successfully message is displayed, click Ok.
After refreshing, the Storage space-used option displays value Zero (0 B).

7. After selecting the preferences, click Apply.

● The repositories can be stored in a local storage location, a mapped network shared location, or Common Internet File
System (CIFS) share location only.

● The NFS share is not supported.

Configure plug-in settings
Configure the plug-in settings to update the available plugins in the DRM application.

Prerequisites

● For windows operating system, ensure that you have required access—(read or write, list folder contents, so on) to the
NT AUTHORITY\LOCAL SERVICE account in the directory including all sublevel directories. The access is required to
export, import, download a repository, add a catalog, update a plug-in, or configure the storage location in Dell Repository
Manager > Application Preferences.

● For Linux users only, ensure that you have read and write access to the drmuser account in the particular directory
including all subdirectories. The access is required to export, import, or download a repository, add a catalog, update a
plug-in, or configure the storage location in Dell Repository Manager > Application Preferences.

● Add the signature file in the same location as the repository. Signature file is used for security validation of the plugins that
are supported with DRM.

● Ensure that the plug-in and sign files have the same name. For example, if the plug-in file name
is Systems-Management_Application_FT56W_LN64_1.6.0_A00.BIN, then save the sign file as Systems-
Management_Application_FT56W_LN64_1.6.0_A00.BIN.sign.

● Add the signature file in the same location as the repository for files of the following formats such as tar.gz, .cab, .bin.

Steps

1. Click Dell Repository Manager > Application Preferences.
The Preferences window is displayed.

2. In the left pane, click Plug-ins. Select and update the plug-ins that are based on the deployment methods you use:
● Dell Bootable ISO Plug-in for using Smart Bootable ISO script type and Platform Smart Bootable ISO features.

NOTE: The forced Update option is supported on Bootable ISO Plug-in 902.2 and above.

● Dell Server Update Utility x64 plug-in for using SUU ISO script type in GUI mode.
● Dell System Update (BIN) for using Smart Deployment Script for Linux script type.
● Dell System Update (EXE) for using Smart Deployment Script for Windows script type.

● The latest used plug-in versions are displayed in Current version and are available in the store local path.
● If any of the plug-ins is not downloaded, then the status of the plug-in displays as Not available in Current version.

The latest plug-in version is displayed in Available version.

3. In Update Actions—select whether to automatically download new versions of the plug-in or notify when a new version is
available.

● The Alert when a new version of plug-in is available option is selected by default that displays the latest versions in
Available version and gives a notification on the DRM home page.

● Select the Automatically download new versions of plug-ins when available option to ensure that you have the
latest versions of the plug-ins and click Apply.

4. In Source of Plug-in Update, select the source of plug-in update from the available options, Dell Online and Folder that is
the local location or the network shared location (Common Internet File System and Server Message Block v2).
● If selecting Dell Online option, click Apply.
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● If selecting the Folder option, browse for the folder where the plug-ins are downloaded. For network locations, enter the
location name, username, password, and then click Add.

5. Select the required plug-in from the Plug-ins section and click Update.

6. Click Apply.

7. When a Preferences saved successfully message is displayed, click Ok.

Results

A job is created in Dell Repository Manager > View > Jobs to update the plug-in which is downloaded to the specified
storage location by default.

NOTE: If multiple versions of the same plug-in are available in the selected plug-in update source location, then all versions

of the plug-in are displayed in the Preferences window instead of the most recent version. Click Update to refresh the list

and view the most recent version of the plug-in.

Configure catalogs settings
Configure the catalog settings to obtain the update information and determine the availability of new updates in the repository
created from the source. Add a catalog, or delete a catalog, or update a catalog with the latest available versions.

Prerequisites

Prerequisite:

● If you install or upgrade DRM 3.4.3 or later with restricted access mode on Windows operating system, ensure that you
have required access (read or write, list folder contents, so forth) to the NT AUTHORITY\LOCAL SERVICE account in the
directory including all sublevel directories. The access is required to export, or import, or download a repository, or add a
catalog, or update a plug-in or configure the storage location in Dell Repository Manager > Application Preferences.

● For Linux users only, ensure that you have read and write access to the drmuser account in the particular directory including
all sublevel directories. The access is required to export, import, or download a repository, add a catalog, update a plug-in, or
configure the storage location in Dell Repository Manager > Application Preferences.

● Ensure that the catalog file and sign file have same names.
● Ensure that you add the catalog and signature files in the same location.
● Add the signature file with same name in the same location as the repository for files with formats such as .xml.gz and .gz.

About this task

The various catalogs are:
● Enterprise server catalog
● Index catalog
● Catalogs for specific solutions:

○ ESXi Catalog—Recommends firmware or BIOS versions for ESXi.
○ Validated MX Stack Catalog—Recommends firmware or BIOS versions for MX platform devices.
○ Lifecycle Controller Catalog—Updates in the Microsoft Windows DUP format.
○ vSAN Catalog—Recommends updates for vSAN solution.
○ Dell Solutions for Microsoft Azure Stack HCI—Recommends firmware or BIOS versions for Microsoft Azure.

Steps

1. Click Dell Repository Manager > Application Preferences.
The Preferences window is displayed.

2. In the left pane, click Catalogs to add, or delete, or update the catalogs.

3. In Update Actions, a new catalog is automatically downloaded and updated or notifies when a new catalog is available.
● If you select Automatically download and update new catalogs when available option, the catalogs start updating

every two hours from the downloads.dell.com with the latest available versions.

NOTE: A notification is displayed every two hours about the catalog update.

● If you select Alert when catalog is available, a notification is available in the upper right corner on DRM home page.
● If you select None, unable to receive notifications and unable to update the catalog.

4. After selecting the preferences, click Apply.
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Results

● It is recommended to add a maximum number of 10 catalogs. Adding catalogs more than 10 impact the performance of DRM.
Hence, delete the catalogs that are not in use.

● By default, the Enterprise catalog is selected as Base catalog when creating a repository.
● A notification is displayed every two hours with the information about the catalog update.
● If the catalog update is unsuccessful, a notification is displayed in the upper right corner of the DRM home page.

Configure DRM to use SUU as a content source
This section describes the process to configure DRM to use SUU as a content source.

Prerequisites

Add the repository folder from the SUU ISO file to the local path using one of the following methods:

● If the SUU ISO file is mounted, copy the repository folder from the mounted SUU to any local path.
● If the SUU ISO file is copied to a local path, extract the repository folder to a local path.

Steps

1. Click Dell Repository Manager > Application Preferences.
The Preferences window is displayed.

2. In the left pane, click Store.

3. Click Browse to select the repository folder path.

4. Click Open and then click Apply.
A new store path is set for the repository.

NOTE: Ensure that the new store path has sufficient storage space.

5. To use an SUU ISO file as a repository, create a manual repository by clicking Add repository.  From the Base catalog
drop-down menu, select the catalog.xml file from the extracted repository folder.

6. Select the repository that is created from the SUU catalog and run any download or export operation.
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Create Repositories
DRM enables you to create a repository that contains multiple system bundles and allows you to manage baselines and create
deployment tools. Repositories provide access to inventory and catalog updates, ensuring you to stay up to date with the latest
releases. Repositories are categorized in three types: Manual, CMC inventory, and Integration.

If a system is unable to reach downloads.dellcom, then anything that is bundled with DRM installer that is downloaded from
the Dell support site, is used for repository creation.

If the catalog update is unsuccessful or not reachable, a notification is displayed on DRM home page.

Topics:

• Create manual repository
• Create repository with integration
• Create repository with CMC inventory
• Create an empty repository

Create manual repository
This section describes the process to create a repository manually with a required update package using GUI or CLI method. Use
the customized repository to apply the updates.

About this task

The operating systems are not supported with manual repository creation, and inventory is not available.

NOTE: The servers that reached end of support life are not available in the latest catalogs. If you require updates for

such servers, create a repository by selecting the Base Catalog as Index catalog, and select Catalog Group as Update

Catalog (GZ format) for Enterprise Servers and select an older catalog version that is supported for same servers.

Steps

1. On the Dell Repository Manager home page, click Add Repository.
The Add Repository window is displayed.

2. Enter the Repository Name and Description.

3. From the Base catalog drop-down list, select a catalog to be used as the base catalog for the repository.

● By default, an Enterprise Sever Catalog option is selected. The other available options are Index Catalog, or None
(for an empty repository), or Choose File if you want to add a custom base catalog that is saved in a local or a shared
location.

● If you select Choose File option to add a custom base catalog, select the catalog file that is saved in a local or common
shared location. The previously loaded catalogs are also listed alongside the Choose File option.

4. In the Repository type section, click Manual to select the required PowerEdge server systems whose components are
added in the repository.
● Select All systems in base catalog to apply updates to all the systems.
● Select Custom > Choose Systems to select the systems individually to apply the update. The Select Systems window

is displayed.
○ In the Line of Business section, select the check box of the PowerEdge.
○ From the list, select the systems that you want to include in the repository from the list. The search box enables you

to locate and select the specific server models or choose Select All option to include all listed server models. The
selected PowerEdge system is displayed in the right pane of the window×.

○ Click Save.

5. In the Operating systems section, select All operating systems in base catalog option to apply updates to all the
operating systems or select Custom > Choose Operating Systems to select the operating systems whose updates are to
be in the repository.

6
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● Select the checkboxes of the required operating systems and DUP formats. The search box enables you to search for
and select the specific operating systems or choose Select All to include the displayed operating systems.

● Click Save.

6. In the Components, select All components types and devices in base catalog option to apply updates to all the devices, or
select Custom > Choose Components to select the components to be in the repository.
● In the Component type, select the check box of the required components. The search box enables you to search for

and select the specific components or choose Select All to include the displayed components.
● Click Save.

7. Select Add to create the repository.
The repository is created and displayed on the Dell Repository Manager home page.

Create repository with integration
This section describes the process to create a repository with the supported Dell consoles to manage the Dell PowerEdge
servers.

Steps

1. On the Dell Repository Manager home page, click Add Repository.
The Add Repository window is displayed.

2. Enter the Repository Name and Description.

3. Select a catalog from the Base catalog drop-down, to be used as a base catalog for the repository.

● By default, an Enterprise Sever Catalog option is selected. The other available options are Index Catalog, or None (for
an empty repository), or Choose File.

● If you select Choose File option to add a custom base catalog, select the catalog file that is saved in a local or common
shared location. The previously loaded catalogs are also listed alongside the Choose File option.

4. In the Repository type, click Integration.

5. In the DUP Format, select the check box of the format that you want in the repository. The available options are: Linux,
Windows-64, and OS-Independent.

Dell consoles deploy firmware using DUPs in the Windows format (.exe).
NOTE:

● If you do not select any DUP format, then based on the console integration you select in the Integration Type, the

applicable DUP formats are selected automatically.

● Modify the default selection of the DUP format when required. If you do not require the default selection, clear the

check box, and all the DUP formats are considered for repository creation.

6. In the Integration Type drop-down menu, select the console with which you want to integrate. The available options are:
● iDRAC—Hostname or IP, Port Number, Username, Password, and proxy server.
● Dell OpenManage Enterprise—hostname or IP address and port number, Username, Password, and proxy server. The

supported format is IP-Address or hostname.

● Dell OpenManage Essentials—Hostname or IP, Port Number, Username, Password, and Proxy Server.
● Dell OpenManage integration for VMware vCenter (OMIVV)—Virtual Appliance IP, vCenter Server IP, Username,

Password, and proxy server.
● Dell OpenManage Integration for Microsoft Systems Center (OMIMSSC)—hostname or IP address and port

number, Username, Password, and Proxy Server. The supported format is IP-Address or hostname.

The integration of the supported Dell consoles is applicable for the consoles that have incorporated the web services such as
OpenManage Integration for Microsoft System Center and OpenManage Enterprise v3.0 or later versions.

7. After selecting the required console for integration, enter the credentials and click Connect.
The available system and models are displayed in the Integration Type section.

8. Select Add to create the repository.
The repository is created and displayed on the Dell Repository Manager home page.

NOTE: Repository creation may fail when there are no applicable updates for Operating System-Independent format for

iDRAC integration.
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Create repository with CMC inventory
This section describes the process to create a repository with the inventory using GUI or CLI method. For information about
collecting the inventory, see Dell Chassis Management Controller for PowerEdge M1000e Users Guide.

Steps

1. On the Dell Repository Manager home page, click Add Repository.
The Add Repository window is displayed.

2. Enter the Repository Name and Description.

3. Select a catalog from the Base catalog drop-down, to be used as a base catalog for the repository.

● By default, an Enterprise Sever Catalog option is selected. The other available options are Index Catalog, or None
(for an empty repository), or Choose File if you want to add a custom base catalog that is saved in a local or a shared
location.

● If you select Choose File option to add a custom base catalog, select the catalog file that is saved in a local or common
shared location. The previously loaded catalogs are also listed alongside the Choose File option.

4. In the Repository type, click CMC Inventory.

5. In the DUP Format, select the check box of the operating system formats that you want in the repository. The available
options are: Linux, Windows-64, and OS-Independent.

6. In Inventory, click Browse and go to a network or local storage path where the inventory is saved.

7. Select the required inventory file and click Open > Add.
The repository is created and displayed on the Dell Repository Manager home page.

Create an empty repository
This section describes the process to create an empty repository.

Steps

1. On the Dell Repository Manager home page, click Add Repository.
The Add Repository window is displayed.

2. Enter the Repository Name and Description.

3. From the Base Catalog drop-down list, select None.

4. Click Add.
The repository is created and displayed on the Dell Repository Manager home page.
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Manage Repositories
This chapter describes the management of repositories. Using DRM, you can perform the basic tasks such as work with the
created repositories. Dell Repository Manager creates a database in the system during the installation process.

Dell Repository Manager dashboard displays the list of created repositories. Perform the following operations:

● Edit, Delete, or Refresh Repositories—Modify repository details, or remove repositories, or update repository
information.

● Work with Components—Download or import components, and copy components to either new or existing repositories.
● Bundles Management—Add, copy, delete, or clone bundles within repositories.
● Using Filters—Using filters to search for specific repositories based on criteria such as criticality, category, and component

types that require updates.
● Job Management—View and manage scheduled jobs, giving you the ability to edit or delete them as needed.

Topics:

• View repository
• View repository properties
• Edit repository
• Compare and update repository
• Refresh repository
• Delete repositories
• Manage bundles in the repositories
• Delete components from bundle
• Copy bundles and components
• Clone bundles
• Work with DUPs or components
• View and manage jobs
• Work with filters
• Save and mail logs

View repository
After creating the repositories, view the repositories in Dell Repository Manager drop-down menu. Click Dell Repository
Manager > Home, or click Dell Repository Manager > Repositories.

View repository properties
View the details or properties of the created repositories on the Dell Repository Manager home page.

Steps

1. On the Dell Repository Manager home page, select the repository for which you want to view the properties.

2. The details of the selected repository are displayed in the Property section available in the right pane of the home page.
The property includes information such as, Name, Version, Type, Number of Bundles, Number of Components, Date,
Size, and Available Versions.

NOTE: To refresh the inventory of integration type of repositories, click Refresh Inventory.

7
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Edit repository
This section describes the process to edit the details of a created repository.

Steps

1. On the Dell Repository Manager home page, select a repository.
The Property window is displayed.

2. In the right pane, click Edit to edit the selected repository.
The Edit window is displayed.

3. Edit or update the required fields—Name, Label, or Description.

NOTE: The command-line interface (CLI) mode is supported for editing only the Repository Name. For more

information, see command-line interface section.

4. Click Save.

Compare and update repository
Compare the repository from the components or platforms with the selected repositories for any new updates available in the
catalog and online repositories. Update the components, bundles, repository of a repository and catalogs to the latest version by
clicking Update in the compare window.

Steps

1. On the Dell Repository Manager home page, select a repository that you want to compare.

2. Click Compare.
The Compare window is displayed.

3. In the View section, select the Component View or Platform View.

The updates that are available in the catalog are displayed on the Compare window. The names of DUPs in the created
repository are different when compared with the DUP names in the latest catalog version available in the Compare window.
View and compare the repository version with the latest catalog version.

4. In the Filter section:
● From the Type of Change drop-down, select the required preferences. The available options are Upgraded,

Downgraded, and No Change.
NOTE: When you select Upgraded for a specific PowerEdge server to upgrade DUP components, then the

same DUP components across different PowerEdge platforms bundles in the same repository are also updated

automatically.

● From the Criticality drop-down list, select the criticality as Urgent, Recommended, or Optional.

5. Click Update.
If you have any updates between the previous and the latest version of the catalog, the changes are displayed.

NOTE: When no updates are available, the Update tab is disabled.

Refresh repository
This section describes the process to refresh a repository or schedule a refresh job for a required interval.

About this task

The refresh operation updates the components in the repository with the latest version available in the Enterprise Server
Catalog.

A repository can be linked to only one refresh job.

NOTE: If the servers or components in the repository are not available in the Enterprise Catalog, then those servers or

components cannot be refreshed. The servers and components available in the latest Enterprise Catalog are refreshed.
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Steps

1. On the Dell Repository Manager home page, select the repositories that you want to refresh.

2. Click Refresh.
The Refresh window is displayed, and the selected repositories are displayed.

3. Select the Frequency as now, daily, weekly, or monthly.

Ensure that you select different repositories for refresh operation. If you select the same repository, a warning message is
displayed.

4. In Settings, select the day or date for the weekly and monthly cadence and set the Start Time.

5. Enable the Send email notification on refresh completion option and enter an email address to notify users and click
Save.

Results

To view the status of the refresh job, go to Dell Repository Manager > Jobs.
NOTE: If a refresh job fails, use one of the following paths to view the logs:

● For windows operating systems—C:\ProgramData\Dell\drm\log
● For linux operating systems—var/dell/drm
● Go to Dell Repository Manager > Help and Support > Save and Mail logs, and then download or send an email.

View the downloaded logs using path C:\ProgramData\Dell\drm\log /drmservice-0 file.

Delete repositories
This section describes the process to delete the created repositories.

About this task

NOTE: The deletion of the repository deletes all the scheduled export and refresh jobs that are associated with that

repository. It is recommended to delete the repository or the jobs only if the scheduled jobs (export and refresh) are not in

running state.

Steps

1. On the Dell Repository Manager home page, select a repository or multiple repositories.

2. Click Delete.
A Delete window is displayed as a warning to confirm the deletion.

3. From the Repository drop-down, select the check box of the versions that you want to delete. To delete all versions, click
All Versions check box.

NOTE: Only the latest repository version is deleted if you do not select the check box.

4. Click Delete.

NOTE: If you select all the repositories and if you do not select Delete all Repository version check box in the Delete

window, then only the current versions of the selected repositories are deleted. However, the older versions of the

repositories are retained.

Manage bundles in the repositories

Add bundles

This section describes the process to add bundles in a repository.

Bundles are added in three ways:

● Add bundles manually
● Add empty bundles
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● Copy bundles from another repository

Add bundles manually

This section describes the process to add bundles manually in a repository.

Steps

1. On the Dell Repository Manager home page, select a repository and click Add Bundles.
The Add Bundles window is displayed.

2. In Bundle Type, select Manually add the bundles.
The Select Systems section is displayed.

3. Click Choose Systems.
The Select Systems window is displayed.

4. From the Line of Business section, select the PowerEdge systems that you want to include or click Select All to include all
the listed systems.
The selected PowerEdge system is displayed in the right pane of the window.

5. Click Save.

6. Click Choose Operating Systems.
The Operating Systems window is displayed.

7. Select the operating system and DUP format. The available options are Linux, WIndows-64, and OS-independent.
The relevant list of DUPs is displayed at the bottom.

In the search box, enter the DUP name, or select the required DUP from the list, or click Select All to include all the listed
DUPs. The selected operating systems are displayed in the right pane of the window. Click Save.

8. Click Choose Components.
The Components window is displayed.

9. In the Component Type, select the check box of the required components and click Save.
The relevant list of devices is displayed at the bottom.

10. In the search box, enter the device name or select the device from the list, or click Select All to include all the listed
devices.
The selected devices are displayed in the right pane of the window. Click Save.

11. Click Add to add the bundle with the selected preferences.

Results

Adding bundles results in an increment of the repository version.

Add empty bundles

This section describes the process to add empty bundles.

Steps

1. On the Dell Repository Manager home page, select a repository and click Add Bundles.
The Add Bundles window is displayed.

2. In Bundle Type, select Add an empty bundle.

3. Enter the bundle name in the Bundle Name text field.

4. From the DUP format drop-down list, select the DUP type. The available options are: Linux, Windows-64, and OS-
Independent.

5. From the Systems drop-down list, select the systems and click Add.
An empty bundle is added in the selected repository.

6. Click Add.

NOTE: The name of the empty bundle is not unique. However, the DUP name and platform must match for the bundle

to be displayed. The combination of the DUP format and the platform or system determines the bundle type.

24 Manage Repositories



Results

● Adding an empty bundle results in an increment of the repository version.
● The size of an empty bundle shows size as 0 bytes in the respective repository on the Dell Repository Manager home page.
● The name of an empty bundle is not unique. However, the DUP name and platform must match for the bundle to be

displayed. The combination of the DUP format and the platform or system determines the bundle type.
● The name of an empty bundle changes to the added bundle.

Next steps

Select the repository where an empty bundle is added. Click the bundle and click Add Bundles > Copy bundles from another
repository..

Copy bundles from another repository

This section describes the process to copy bundles from the selected repositories to the target repository.

Steps

1. On the Dell Repository Manager home page, select a repository and click Add Bundles.
The Add Bundles window is displayed.

2. In the Bundle Type, select Copy bundles from another repository option.

3. From the Select Repository drop-down, select the repository and select the bundle.
The selected bundles are displayed at the bottom.

4. Click Add to copy the bundle.

Results

● Copying the bundles result in an increment of the repository version.
● When you add an empty bundle, and try to copy files from the same platform type and same operating system from another

repository, replaces an empty bundle name with a newly added bundle.

Delete bundles

This section describes the process to delete the selected bundles.

Steps

1. On the Dell Repository Manager home page, select a repository.

2. Expand the repository list to view the bundles associated with that repository.

3. Select a bundle or more bundles from another repositories and click Delete.
A Delete window is displayed as warning to confirm the deletion.

4. Click Delete.

Results

Deleting the bundles or components results in an increment of the repository version. However, an older version of the
repository retains the deleted bundles

Delete components from bundle
This section describes the process to delete the components from bundles.

Steps

1. On the Dell Repository Manager home page, select a repository.

2. Expand the repository list to view the bundles associated with that repository.

3. Select a bundle and expand the tree to view the components associated with the bundle.
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4. Select a component to delete or select multiple components from different bundles in a repository or from different
repositories.
A Delete window is displayed as warning to confirm the deletion.

5. Select the Delete from all the bundles in the Repository check box if you want to delete from all the bundles.

6. Click Delete.

Results

Deleting the components from bundles results in an increment of the repository version. However, an older version of the
repository retains the deleted components.

Copy bundles and components
This section describes the process to copy components from one bundle to another bundle or copy one or multiple bundles from
one repository to another repository.

About this task

If DUPs are available within the DRM application, then use Copy feature to copy the components. Use an import feature if DUPs
are not available in the DRM application but outside DRM or in the network share or local storage path.

Steps

1. On Dell Repository Manager home page, select and expand a repository to the bundles associated with that repository.

2. Select the bundle and click to expand the list of the components associated with that bundle to be copied.

3. Select the component and click Copy.
The Copy components window is displayed.

4. From the Select Repository drop-down list, select a repository and select the bundle where you want to copy the
components.
The Selected bundles contains the bundle that you selected earlier.

5. Click Add.
The bundles or the components are added in the repository.

Results

Copying the bundles and components result in an increment of the repository version.

Clone bundles
This section describes the process to clone the selected bundles from a repository to a different repository.

Steps

1. On the Dell Repository Manager home page, select a repository.

2. Expand the repository to view the bundles associated with that repository.

3. Select a bundle and click Clone.
The Clone Bundles window is displayed.

4. From Select Repository drop-down list, select the repository and click Clone.

Results

Cloning a bundle results in an increment of the repository version.
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Work with DUPs or components
All the Dell Update Packages (DUPs) and non-DUPs for example—.exe, .msi, .bin, or any other file formats are called as
components. DUPs are used for updating the Basic Input or Output System (BIOS), firmware, drivers on specific platforms or
any other application.

DUP dependencies

The feature articulates the relationship between the two different DUPs. A Server Update Utility (SUU) enables certain
rules and submissions to determine if the conditions or requirements are met. These conditions or requirements are called
dependencies. Dependency exists when a DUP of a particular type has a dependency on an additional DUP for further execution.
This helps the users to determine, which DUP to install first and which one to follow. The two types of dependencies are:
● Hard dependency—that must be applied in order to be able to apply the update.
● Soft dependency—that must be applied in order to use certain new features coming with an update.

NOTE: In the certain scenarios, for a complete update or upgrade, ensure that you install two and more DUPs. Restart the

system for individual DUPs to realize the impact of other installed DUPs.

DUP conventions for DRM

This section describes the use of Dell update packages (DUPs) with the supported Dell PowerEdge servers.

DUPs are update packages from Dell, which help you to keep your system up to date. DUPs are application that are available
in various formats; Windows 64-bit, and Linux (64-bit). For 13th generation PowerEdge servers or later select 64-bit operating
systems. For more information about this format, see Identifying the generation of your Dell PowerEdge servers.

View component properties

This section describes the process to view the properties of components.
1. On the Dell Repository Manager home page, select a repository that you want to view.
2. Expand a repository to view the bundles associated with that repository.
3. Select a bundle and click to expand the list of components associated with that bundle.

The properties of the component are displayed in the right pane of the Property section.

NOTE: If the dependant DUPs are available for a DUP, it is displayed in the Properties section as prerequisites. The

dependant DUPs are exported or downloaded automatically with the selected DUPs.

Download components

This section describes the process to download components associated with a bundle.

About this task

No catalog is available in the download path. After the download of the DUPs is completed, the DUPs are then directly available
in the download path and not in a folder structure.

NOTE: If a DUP is initiated for download with a dependent DUP, then the dependent DUP also gets downloaded at the

same location.

Steps

1. On the Dell Repository Manager home page, select the repositories that have the components you want to download.

2. Expand the repository to view the bundles associated with that repository.

3. Select a bundle and click to expand the list of components associated with that bundle.

4. Select the components and click Download.
The Download Components window is displayed.

5. Click Browse and go to the location (local or network path) to save the download and click Open > Download.
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NOTE: To download the component to a shared location, enter the location name in the format \\IP
address\folder location. Provide the relevant credentials in the Network window and click Add. Login with

the relevant credentials and select the location to download the components.

Import components

This section describes the process to import Dell components or DUPs associated with a bundle from local or network share
path. If a DUP is initiated for an import with a dependent DUP in a repository, then the corresponding dependent DUP must be
available at the same location. A DUP can be imported to an empty repository with having supported empty bundle added in the
repository.

Prerequisites

● Add the plug-in and signature files in the same location where the repository is available.
● The plug-in and sign files have the same name.
● Add the signature file in the same location of the repository for files of the supported formats—tar.gz and .bin.

NOTE: For windows DUPs (.exe) the signature file is embedded.

Steps

1. On the Dell Repository Manager home page, select the repository and bundle where you want to import the components.
Click Import.
The Import component window is displayed.

2. Click Browse and go to the location (local or network path) that you intend to import the components, and click Open.

● The verify component signature checkbox is selected by default.
● To import the components from a network shared location, log in to the shared location by providing the appropriate

credentials and select the components to import.

3. Click Import.
The component is successfully imported to the specified repository.

Results

● The import of components to a repository results in an increment of the repository version.
● Only one DUP can be imported using Graphical User Interface (GUI). And import the multiple DUPs using the Command Line

Interface (CLI).
● Verify the signature of the DUPs, if not done before importing.

View and manage jobs

About this task

This section describes the process to work with scheduled jobs such as refresh, download, or export, or plugin update, or
catalog update, or platform bootable ISO creation, that are triggered and listed in the jobs view of DRM.

Steps

1. Click Dell Repository Manager drop-down menu.

2. Click Jobs.
The Jobs page is displayed. The jobs page displays the triggered job name, status, next execution date/time, last execution
date/time, affected repositories, and logs.

3. In Logs, the Show Log option is displayed for certain jobs. This option provides more details about the job.

Results

To view the details about any failure in the job, go to service logs. For more information, see /var/dell/drm/log/
drmservice-0.log file in Linux operating system and /programdata/dell/drm/log/drmservice-0.log file
in windows operating system.
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A progress bar displays the status of a job that is executing.

Next steps

You can Edit and Delete the created jobs.

Edit jobs

Edit the scheduled jobs or the completed jobs on the Jobs page for refresh and export jobs. The refresh jobs are edited to
refresh the repository in accordance with the latest available enterprise catalog version in DRM. The editing of an export job is
enabled to update the scheduled frequency.

Steps

1. Click Dell Repository Manager > Jobs.
The Jobs page is displayed.

2. Select the job and click Edit.
● To edit a refresh job, click Edit to refresh the job in accordance with the latest available enterprise catalog version in

DRM and click Save.
● To edit an export job, click Edit to update the scheduled Frequency as daily, monthly or weekly. Select the day or date

for weekly and monthly cadence and set the Start time. Click Save.
NOTE:

○ The editing of one time Run now export jobs is not supported.

○ The recurring schedule of an export job overwrites the existing content on the same target location.

Results

The status of the triggered edit job is updated to scheduled state and runs as per the selected frequency.

Delete jobs

Delete the scheduled jobs, unsuccessful jobs, or completed jobs for any DRM operations on the Jobs page.

About this task

NOTE: Deleting a scheduled or running export job or refresh jobs delete the created job from the Jobs page. It is

recommended to delete the jobs only if the scheduled jobs are not in running state.

Steps

1. Click Dell Repository Manager > Jobs.
The Jobs page is displayed.

2. Select the job that you want to delete and click Delete.
A warning message is displayed to confirm the deletion.

3. Click Delete.

NOTE: The deletion of an export job does not impact the exported content such as catalogs, DUPs.

Work with filters
This section describes the process to work with options to filter the repositories based on conditions.

Steps

1. On the Dell Repository Manager home page, select the repositories that you want to filter.
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2. Click  icon available in the upper right corner of the interface.

3. Set the preferences to filter the repositories. The available conditions are Criticality, Category, and Type. In Search box,
enter a particular component or a bundle.

4. From the Criticality drop-down menu, select the required preference. The available options are, Urgent, Optional, and
Recommended.

5. From the Category drop-down menu, select the required category. For example, Application, Audio, BIOS, or other
available categories.

6. From the Type drop-down menu, select the required components.

7. After the preferences are set, click Apply.

The components are displayed based on the selected preferences. The filter icon changes to .
● The image of the filter changes to an animation image after successfully applying the filters.
● The arrow next to the filter icon points down when the filter is hidden.
● The arrow next to the filter icon points down when the filter is expanded and applied.

NOTE: After you apply a filter, the result pertaining to the selected filter preference is displayed. Click Reset to revert

to the default view of the repository.

Example

Search and select the components by entering the keywords of the components. For example, type Fibre in the search bar and
click Apply to search all the instances with the keyword Fibre in all the repositories. To revert to default preferences, click
Reset.

Next steps

If you delete, copy, or download the components after applying filters, only the filtered data is available and an entire repository
is not displayed. When you delete the filtered content, an empty repository is displayed. Click Reset to view the other

components in the repository. The filter logo is changed to .

Save and mail logs
This section describes the process to save and email the logs.

Prerequisites

Configure the email settings to send and download the logs.

Steps

1. Click Dell Repository Manager > Save and Mail logs.
The Save or Mail Logs window is displayed.

2. Enter the email address of the recipient and click Send to send the logs through email address by configuring the email
settings.

To configure the email settings, see Configure notifications.

3. Click Download to save the logs to a local location or a network shared location.

● In CLI mode, the DRM logs are downloaded to a network share location, only if you have accessed the network share
location before on the system. However, unable to download the DRM logs when the network share location is not
accessed before.

● In GUI mode, to download the DRM logs in network share location if not accessed before, it prompts to log in with the
user credentials for first time. However, after accessing the network share location once, it does not prompt for the
credentials and DRM logs are downloaded to the same network share location.

NOTE: The DRM service connection is reestablished irrespective of the message Lost connection, waiting
for DRM service to connect that is displayed on the GUI when you save or replace the logs to a local or network

shared location.
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Export the deployment tools
This chapter describes the process of creating and exporting the customized deployment tools to update the firmware or drivers
of the Dell PowerEdge servers. This enables the deployment of the repository to a particular set of systems.

Prerequisites

● Install the plugins before you start with exporting of deployment tools except export as share option.
● Local service access is enabled before using an export feature.

About this task

The export jobs are scheduled for the latest repository versions and for the desired intervals by selecting either of
the frequencies (Daily, or weekly or monthly) and time. For DRM v3.4.4 or later, the exported share catalog name is
<reponame>_catalog.xml.

To export the deployment tools with date and time:

● Allows only one export job with same repository and same deployment type.
● Delete an existing export job if you want to use the same repository and same deployment type.
● The recurring schedule of an export job overwrites the existing content on the same target location.

Steps

1. On Dell Repository Manager home page, select the repositories or bundles for which you want to create the deployment
tools. Dell System Update (DSU) is used in orchestrating the deployment.

2. Click Export.
The Export Deployment Tools window is displayed. The repositories that you select are displayed in the Selected
Repositories section.

3. To schedule an export of a repository for any interval, enable the Schedule Job option. Select the Frequency as Daily or
weekly or monthly. Select the day or date for weekly and monthly cadence and set the Start time.

NOTE: If you do not enable the Schedule Job option, then by default the created job is submitted to run at once. The

editing of one time job is not supported.

4. In the Deployment Tool Type section, select the required deployment tool to be created for the updates.

Select Click to Configure and update the plug-in, if the required plug-in is not available.

The available options are:

● Smart Bootable ISO—supports Linux bundles only. Select the Replace Default Script checkbox to get the custom
scripts. You can force an update by selecting an Enable Force Update checkbox. Reboot the Dell system when required
by selecting the Reboot system automatically checkbox. For more information, see Create a smart bootable ISO.

● SUU ISO—supports the Server update utility (SUU) as an ISO image file. Select Save SUU to Directory checkbox to
save the files. For more information, see Create a Server Update Utility (SUU) ISO.

● Smart Deployment Script—select the Script Type as Microsoft windows or Linux operating systems. If you want
to use custom scripts, select the Replace Default script checkbox. Specify the script to start before or after the
deployment script is started by selecting the Pre-Script or Post-Script or select a custom script. You can force an
update by selecting an Enable Force Update checkbox. For more information, see Create a smart deployment script.

● Share—exports the repository as Local storage or network share. You can export only the catalog by selecting an
Export only catalog checkbox. For more information, see Export repository as share.

5. Select the required preferences and click Export.

Results

NOTE:

● DSU v1.6 or later is required to use the Enable Force Update option.

8
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● When you select a lower version of a repository, you have an option to delete all the higher versions of the repository on

the Export Deployment Tools window.

● If a plug-in update is available, a message is displayed. You can configure and set the plug-in preferences. For more

information about configuring plug-in preferences, see Configuring plug-in preferences.

Topics:

• Create a smart bootable ISO
• Create a Server Update Utility (SUU) ISO
• Create a smart deployment script
• Export repository as share
• Create a PowerEdge server-based platform bootable ISO

Create a smart bootable ISO
This section describes the process to export the repository to a smart bootable ISO using linux bundles updates of the
repository.

About this task

NOTE:

● Secure Boot is not supported with smart Bootable ISO.

● Only Linux DUPs are supported and exported as Bootable ISO.

Steps

1. On Dell Repository Manager home page, select the repositories or bundles for which you want to create the deployment
tools.

If you do not select any repository, a warning message is displayed.

2. Click Export.
The Export Deployment Tools window is displayed. The repositories that you select are displayed in the Selected
Repositories section.

3. To schedule an export of a repository for any interval, enable the Schedule Job option. Select the Frequency as Daily or
weekly or monthly. Select the day or date for weekly and monthly cadence and set the Start time.

NOTE: If you do not enable the Schedule Job option, then by default the created job is submitted to run at once. The

editing of one time job is not supported.

4. In the Deployment tool type section, select Smart Bootable ISO.

5. If you want to use a custom script instead of a default script, and then select the Replace Default Script checkbox, and
click Select.

● During Bootable ISO deployment, the selected custom script is replaced with the default script. Ensure that the custom
script file is not named as apply_bundles.sh.

● Running a custom script requires the relevant libraries to be included and other dependencies to be met on the target
systems.

● Save the script file name using alphabets and numbers only.

6. Click Browse to select the location (local storage or network share) and click Open to download the ISO.

NOTE: Ensure that you provide the required permissions to the parent folder.

7. Select an Enable Force update (Bootable ISO Plugin 902.2 or greater) checkbox, only if the bootable ISO plug-in is
greater than 902.2 version.

The equivalent updates cannot be deployed on Dell systems with enable force update for the repository having iDRAC
dependency DUP.

8. Select Reboot system automatically checkbox, when required and click Export.
View the status of an export job, in Dell Repository Manager > Jobs.

32 Export the deployment tools



Results

NOTE:

● If an exported repository contains the higher version of DSU DUP, then after applying the updates using an already

installed version of DSU, ensure that you upgrade the DSU version to the latest available version.

● DSU is used in orchestrating the deployment of the update packages.

Example

If any updates require reboot after mounting the ISO file, following is a sample script which allows to reboot the host operating
system:

#!/bin/bash
shopt -s expand_aliases
alias 'rpm=rpm --ignoresize'
mkdir -p /var/cache/yum
mount -ttmpfs tmpfs /var/cache/yum
rpm -ivh --nodeps /opt/dell/toolkit/systems/RPMs/rhel7/yumrpms/*
echo "diskspacecheck=0" >> /etc/yum.conf
echo "Installing dell-system-update ..."
if rpm -U --force /opt/dell/toolkit/systems/RPMs/dell-system-update*.rpm
then
  echo "DSU installation successful ..."
  export LANG=en_US.UTF-8
else
  echo "DSU installation failed."
  exit 1
fi
mkdir -p /usr/libexec/dell_dup/

version=$(dsu -v | cut -d ' ' -f 5)
version=$(echo $version | cut -d' ' -f 1)
installed_version=$(dsu -v | cut -d ' ' -f 5)
installed_version=$(echo $installed_version | cut -d' ' -f 1)
if [[ $installed_version < 1.7.0 ]]
then
echo "Trying to Upgrade DSU"
/opt/dell/toolkit/systems/drm_files/repository/FOLDER05605556M/1/Systems-
Management_Application_DVHNP_LN64_1.7.0_A00.BIN -f -q
if [[ $? -eq 0 ]]
then
echo DSU update Succesful
version=$(dsu -v | cut -d ' ' -f 5)
version=$(echo $version | cut -d' ' -f 1)
else
echo DSU Update Failed
fi
fi

echo "Starting dsu"
if [[ $version > 1.6.0 ]]
then
dsu --non-interactive --source-location=/opt/dell/toolkit/systems/drm_files/
repository --source-type=REPOSITORY --ic-location=/opt/dell/toolkit/systems/
drm_files/repository/FOLDER05897955M/1/invcol_FJ2R1_LN64_19_12_200_744_A00 --config=/opt/
dell/toolkit/systems/drm_files/dsuconfig.xml --import-public-key --reboot

elif [[ $version > 1.5.3 ]]
then
dsu --non-interactive --source-location=/opt/dell/toolkit/systems/drm_files/
repository --source-type=REPOSITORY --ic-location=/opt/dell/toolkit/systems/
drm_files/repository/FOLDER05897955M/1/invcol_FJ2R1_LN64_19_12_200_744_A00 --config=/opt/
dell/toolkit/systems/drm_files/dsuconfig.xml

elif [[ $version > 1.5.2 ]]
then
dsu --non-interactive --source-location=/opt/dell/toolkit/systems/drm_files/
repository --source-type=REPOSITORY --ic-location=/opt/dell/toolkit/systems/
drm_files/repository/FOLDER05897955M/1/invcol_FJ2R1_LN64_19_12_200_744_A00 --config=/opt/
dell/toolkit/systems/drm_files/dsuconfig.xml

else
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dsu --non-interactive --source-location=/opt/dell/toolkit/systems/drm_files/
repository --source-type=REPOSITORY --ic-location=/opt/dell/toolkit/systems/
drm_files/repository/FOLDER05897955M/1/invcol_FJ2R1_LN64_19_12_200_744_A00 
exit "$STATUS"
fi

Create a Server Update Utility (SUU) ISO
Export the repository to a Dell Server Update Utility (SUU) ISO and run the updates over the operating systems using either an
ISO image file or as a directory. The support of SUU plug-in is enabled internally with the Dell System Update (DSU) engine for
export SUU ISO feature.

Steps

1. On the Dell Repository Manager home page, select the repositories or bundles for which you want to create the
deployment tools.

If you do not select any repository, a warning message is displayed.

2. Click Export.
The Export Deployment Tools window is displayed. The repositories that you select are displayed in the Selected
Repositories section.

3. To schedule an export of a repository for any interval, enable the Schedule Job option. Select the Frequency as Daily or
weekly or monthly. Select the day or date for the weekly and monthly cadence and set the Start time.

NOTE: If you do not enable the Schedule Job option, then by default the created job is submitted to run at once. The

editing of a one-time job is not supported.

4. In the Deployment Tool Type section, select SUU ISO.

NOTE: If you select a lower version of the repository, when the higher versions of the same repository are available,

then Remove all higher versions check box option is displayed on the Export deployment tool window.

5. Click Browse to select the location (local storage or network share) and click Open to download the ISO.

Select the Save SUU to Directory checkbox to save the ISO image files in an expanded format. Thus, SUU is saved in a
non-ISO format.

6. Click Export.
View the status of an export job, in Dell Repository Manager > Jobs.

Create a smart deployment script
This section describes the process to export the repository to a smart deployment script in windows and linux operating systems
by replacing the default script as well as prescript and postscript.

Steps

1. On the Dell Repository Manager home page, select the repositories or bundles for which you want to create the
deployment tools.

If you do not select any repository, a warning message is displayed.

2. Click Export.
The Export Deployment Tools window is displayed. The repositories that you select are displayed in the Selected
Repositories section.

3. To schedule an export of a repository for any interval, enable the Schedule Job option. Select the Frequency as Daily or
weekly or monthly. Select the day or date for the weekly and monthly cadence and set the Start time.

NOTE: If you do not enable the Schedule Job option, then by default the created job is submitted to run at once. The

editing of a one-time job is not supported.

4. In the Deployment Tool Type section, select Smart Deployment Script.

5. Select the type of script from the Script Type drop-down. The available options are: Windows and Linux.
● Windows script type—select the windows bundles from the repository to export.
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● Linux script type—select the Linux bundles form the repository to export.

6. If you want to use a custom script instead of a default script, then select the Replace Default Script check box, and click
Select.

NOTE:

● When you deploy the Smart Deployment Script, the selected custom script is invoked from the default script.

● Running custom scripts require the relevant libraries to be present and dependencies to meet in the target systems.

7. Specify if the script is to be started before or after the deployment script. The available options are Pre-script and
Post-script.

Save the script file name using alphabets and numbers only.

NOTE: Ensure that the file names of the script, or prescript, or postscript are not the same as default script file name.

8. Click Select to choose the script file.

9. Click Browse to select the location and click Open to download the ISO.

10. To force an update, select the Enable Force Update (DSU Plug-in 1.6 or greater) checkbox and click Export.
View the status of an export job, in Dell Repository Manager > Jobs.

Results

When the smart deployment script runs and installs the DSU plug-in (if not preinstalled), performs the updates on the Dell
system components, and then uninstalls the DSU again. Thus, the DSU-generated log and status files are unavailable.

NOTE: If an exported repository contains the higher version of DSU DUP, then after applying the updates using an already

installed version of DSU, ensure that you upgrade the DSU version to the latest available version.

Next steps

After creating the script, download the plug-in and sign files manually.

Export repository as share
Export the content of a created repository as share to a local storage, or network shared location that includes both catalogs
and DUPs.

Steps

1. On the Dell Repository Manager home page, select the repositories or bundles for which you want to create the
deployment tools.

If you do not select any repository, a warning message is displayed.

2. Click Export.
The Export Deployment Tools window is displayed. The repositories that you select are displayed in the Selected
Repositories section.

3. To schedule an export of a repository for any interval, enable the Schedule Job option. Select the Frequency as Daily or
weekly or monthly. Select the day or date for weekly and monthly cadence and set the Start time.

NOTE: If you do not enable the Schedule Job option, then by default the created job is submitted to run at once. The

editing of one time job is not supported.

4. In the Deployment Tool Type section, select Share.

5. Click Browse to select the location (local storage or network share) and click Open to download the DUPs and catalogs.

6. To export only the catalog, select Export only catalog checkbox and click Export.
View the status of an export job, in Dell Repository Manager > Jobs.
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Create a PowerEdge server-based platform bootable
ISO
Create a platform bootable ISO based on PowerEdge server using the latest enterprise catalog from the Dell support site
without creating or using any repository. The platform-based Bootable ISO builds a Bootable ISO that contains all the firmware
update packages for the selected platform.

Prerequisites

● Connect to the Internet before creating a server-based Platform Bootable ISO.
● An adequate space between 2 GB to 5 GB is available in the location for the selected PowerEdge server to save the created

Platform Bootable ISO.
● If you need a customized Bootable ISO, use the Smart Bootable ISO work flow.

About this task

NOTE: The PowerEdge server-based platform bootable ISO does not support scheduled recurring export jobs for ISO

creation.

Steps

1. On the Dell Repository Manager home page, select Platform Bootable ISO.
The Select System window is displayed.

2. Select a PowerEdge server to create a Platform Bootable ISO.
Select the server system from the list, or use the search filter to quickly locate the system.

NOTE: Only one server system can be selected at a time.

3. Click Browse to select the location and click Open where you want to save the Bootable ISO.

The Create tab is enabled.

The Name is available as: <server model>_BOOTABLE_<catalog version>.iso.

4. Click Create.
A job is created on the Jobs page and is available as an alert in the upper right corner of the home page.

Results

● The plug-in updates run in the background on the jobs page, and the latest plug-in version is available in DRM.
● The selected system running with a platform bootable ISO restarts automatically after updating the components.

36 Export the deployment tools



DRM Maintenance
This chapter describes the procedures to upgrade DRM to the latest versions. You can repair DRM or uninstall DRM using GUI
mode or CLI mode on windows operating systems and Linux operating systems.

Topics:

• Upgrade DRM
• Repair DRM using GUI mode on Microsoft Windows Operating Systems
• Repair DRM using CLI mode on Windows operating systems
• Repair DRM using GUI mode on Linux operating systems
• Repair DRM using CLI mode on Linux operating systems
• Uninstall DRM using GUI mode on Windows operating systems
• Uninstall DRM using CLI mode on Windows operating systems
• Uninstall DRM using silent mode on Windows operating systems
• Uninstall DRM using GUI mode on Linux operating systems
• Uninstall DRM using CLI mode on Linux operating Systems
• Uninstall DRM using silent mode on Linux operating systems

Upgrade DRM
Upgrade the DRM to the latest version for better performance. In the DRM application, when a new version of DRM is released,
a notification as bell alert is displayed in the upper right corner of the home page in Graphical User Interface (GUI).

Prerequisites

● In the Windows operating systems, while upgrading to DRM version 3.4.3 or above, If the store path location is set as any of
these custom locations (Windows, Program Files, Program Files x86) in the local drive, irrespective of the selected service
access privilege type, the store path will reset again to default after upgrade.

NOTE: The content available in the custom store locations such as (Windows, or Program Files, or Program Files x86) is

copied to the new default location which is set by DRM while upgrading.

● The cleanup of the installation directory is performed before installing or uninstalling DRM on Windows operating system.
Ensure that you take a backup of installation logs before upgrading DRM.

● If you migrate from the DRM version 2.x to the DRM version 3.x, ensure that you upgrade to version 3.0, and then upgrade
to the specific DRM 3.x version.

● If you upgrade to DRM version 3.4.3 and above, the installation path cannot be altered in Windows and Linux operating
system. The Choose Install Folder and Choose Shortcut Folder options are disabled during DRM upgrade.

Steps

1. Launch Dell Repository Manager.

2. Click Dell Repository Manager > Check for New Version to download and install to the latest version of the repository
manager.

The Set DRM database password option is enabled for DRM version 3.4.x and above to install or upgrade DRM as part of
security enhancements.

Results

● Relaunch the DRM application after a successful upgrade operation.
● After upgrade, to view the Online help (OLH) files, clear the browser's cache and then relaunch the OLH files.
● During DRM upgrade on Windows Server 2019, or Windows Server 2022, the installer may not run

automatically because of windows security policies. Hence, manually run the installer file from the location C:
\Users\username\AppData\Local\Temp.

9

DRM Maintenance 37



Repair DRM using GUI mode on Microsoft Windows
Operating Systems
Repair the Dell Repository Manager through interactive mode on Microsoft Windows Operating Systems:

Steps

1. Click Control panel > Programs > Programs and Features.

2. In the Programs and Features window, select Dell Repository Manager, and click Uninstall or Change.
The Configure Dell Repository Manager wizard opens in the maintenance mode.

3. Select Repair Product, and click Next.

4. Click Install to repair DRM.
The DRM application is repaired.

5. Select Yes, restart my system option or select Yes, I will restart my system myself option to complete the installation
and the changes to reflect in the application, click Done.

NOTE: Restart the system and launch DRM after a successful repair operation.

6. When Service Installation successful message is displayed, click Ok.

Repair DRM using CLI mode on Windows operating
systems
Repair DRM using Command Line Interface (CLI) mode on Windows Operating Systems.

Steps

1. Open the command prompt or command-line interface.

2. Use the path c:\Program Files\Dell\Dell Repository Manager\_Dell Repository
Manager_installation\Change Dell Repository Manager Installation.exe" -i console -repair.

3. Press Enter.
The files are restored.

Repair DRM using GUI mode on Linux operating
systems
Repair the Dell Repository Manager using Graphical User Interface (GUI) mode on Linux operating systems.

Steps

1. Open the command-line interface and go to the location where DRM is installed. By default, the path is set as /opt/dell/
dellrepositorymanager/_Dell Repository manager_installation.

2. Enter the command—./Change Dell Repository Manager Installation
The Configure Dell Repository Manager wizard opens in the maintenance mode.

3. Select Repair Product and click Next.

By default, the Uninstall Product option is selected.
NOTE: The intermittent performance lag is observed when you switch from repair to uninstall for uninstall operation, or

from uninstall to Repair option using keyboard for repair operation during DRM application maintenance.

4. Click Install.
The DRM application is repaired.

5. Select Yes, restart my system option or select Yes, I will restart my system myself to complete the installation and the
changes to reflect in the application, click Done.
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Results

Restart the system and launch DRM after a successful repair operation.

Repair DRM using CLI mode on Linux operating
systems
Repair the Dell Repository Manager using Command Line Interface (CLI) on Linux operating systems.

Steps

1. Open the command prompt or command-line interface.

2. Using the path to repair DRM—/opt/dell/dellrepositorymanager/_Dell\ Repository\
Manager_installation\Change\ Dell\ Repository\ Manager\ Installation -i console -repair.

3. Press Enter.
The DRM files are repaired.

Uninstall DRM using GUI mode on Windows operating
systems
Uninstall the Dell Repository Manager using interactive mode on Microsoft Windows operating systems.

About this task

The cleanup of the installation logs is performed while uninstalling DRM. Ensure that you take a backup of installation logs
before uninstalling DRM.

Steps

1. Click Control panel > Programs > Programs and Features.

2. In the Programs and Features window, select Dell Repository Manager, and click Uninstall or Change.
The Configure Dell Repository Manager wizard opens in the maintenance mode.

3. Select Uninstall Product option and click Next.

● The Remove repository content check box is selected by default to remove the DRM content.
● If you clear the check box, the database is not deleted.

4. Click Next to uninstall DRM.
The Services stopped successfully message is displayed. The DRM files are uninstalled in a few minutes.

5. Click Done.
The uninstallation process deletes the following:
● The created DRM Installer shortcut from the desktop.
● DRM files from the path—Local Disk(C:)>ProgramData>Dell.

Results

When DRM is installed using CLI interactive mode, then to uninstall the DRM using GUI mode on Windows operating system, run
the below command: /Change Dell Repository Manager Installation -i gui.
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Uninstall DRM using CLI mode on Windows operating
systems
Uninstall DRM using a command-line interface (CLI) mode on Windows operating systems.

About this task

The cleanup of the installation logs is performed while uninstalling DRM. Ensure that you take a backup of installation logs
before uninstalling DRM.

Steps

1. Open the command prompt or command-line interface,

2. Use the path c:\Program Files\Dell\Dell Repository Manager\_Dell Repository
Manager_installation\Change Dell Repository Manager Installation.exe" -i console
-uninstall and press Enter.

3. Enter one of the options:

Option Description

1 Remove Database.

2 Do not remove DRM database.

● If you press Enter without giving any option 1 or 2, remove the database by default.
● If you enter option 2, it uninstalls the DRM application without removing the database from Local

Disk(C:)>ProgramData>Dell>drm.

The uninstallation completes in a minute.

Results

When DRM is installed using GUI mode, then to uninstall the DRM using CLI interactive mode on Windows operating system, run
the below command: /Change Dell Repository Manager Installation -i console

Uninstall DRM using silent mode on Windows
operating systems
Uninstall the DRM application using silent mode on Windows operating systems.

About this task

The cleanup of the installation logs is performed while uninstalling DRM. Ensure that you take a backup of installation logs
before uninstalling DRM.

Steps

1. Open the command prompt or command-line interface.

2. Use the path: c:\Program Files\Dell\Dell Repository Manager\_Dell Repository
Manager_installation\”Change Dell Repository Manager Installation.exe” -i silent
-uninstall and press Enter.

Results

DRM database gets deleted from the system.
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Uninstall DRM using GUI mode on Linux operating
systems
Uninstall DRM through Graphical User Interface (GUI) on Linux operating systems

Prerequisites

Log in with the root or administrative privileges.

Steps

1. Open the command-line interface, and go to /opt/dell/dellrepositorymanager/_Dell Repository
Manager_installation and press Enter.

2. Enter the command: ./Change\ Dell\ Repository\ Manager\ Installation and press Enter.
The Configure Dell Repository Manager wizard opens in the maintenance mode.

3. The Uninstall Product option is selected by default. Click Next.
A message is displayed about a confirmation to uninstall DRM.

4. Click Next. Click Previous if you want to review the selected preferences.
The Remove repository content checkbox is selected by default to remove the DRM content.

5. Click Uninstall.

6. When the Services stopped successfully message is displayed, click Ok.
The uninstallation completes in a minute.

7. Click Done.
The DRM files are deleted.

Results

When DRM is installed using CLI interactive mode, then to uninstall the DRM using GUI mode on Linux operating system, run the
command: /Change Dell Repository Manager Installation -i gui.

Uninstall DRM using CLI mode on Linux operating
Systems
Uninstall DRM using a command line interface (CLI) mode or console mode on Linux operating systems.

Steps

1. Open the command prompt or command line interface.

2. Go to the location /opt/dell/dellrepositorymanager/_Dell Repository Manager_installation/ and
enter the following command ./Change Dell Repository Manager Installation.sh -i console
-uninstall

3. Press Enter.
The DRM files are deleted.

Results

When DRM is installed using GUI mode, then to uninstall the DRM using CLI interactive mode on Linux operating system, run the
command: /Change Dell Repository Manager Installation -i console.
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Uninstall DRM using silent mode on Linux operating
systems
Uninstall DRM using silent mode on Linux operating systems.

Steps

1. Open the command prompt or command-line interface.

2. Go to the location /opt/dell/dellrepositorymanager/_Dell Repository Manager_installation/ and
enter the command ./Change Dell Repository Manager Installation.sh -i silent -uninstall.

3. Press Enter.
The DRM files are deleted.
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Related documents and resources
This chapter contains the accessing support and the reference links for the various Dell documentation.

Topics:

• Launch Dell support site
• Accessing support content from the Dell support site
• Other documents you may need

Launch Dell support site
This section describes the process of launching the DRM manuals on the Dell support site.

1. Browse to dell.com/support/manuals.
2. Click Browse All Products to view the Dell portfolio.
3. Click Software & Solutions > Software.
4. Click Enterprise Systems Management.
5. Click Repository Manager.
6. Select the relevant release and click Select this product tab. Dell Repository Manager page is displayed.
7. Click Documentation to view the manuals.

Accessing support content from the Dell support site
Access supporting content related to an array of systems management tools using direct links, going to the Dell support site, or
using a search engine.
● Direct links:

○ For Dell Enterprise Systems Management and Dell Remote Enterprise Systems Management—https://www.dell.com/
esmmanuals

○ For Dell Virtualization Solutions—www.dell.com/virtualizationsolutions
○ For Dell OpenManage—https://www.dell.com/openmanagemanuals
○ For iDRAC—https://www.dell.com/idracmanuals
○ For Dell OpenManage Connections Enterprise Systems Management—https://www.dell.com/

OMConnectionsEnterpriseSystemsManagement
○ For Dell Serviceability Tools—https://www.dell.com/serviceabilitytools

● Dell support site:
1. Go to https://www.dell.com/support.
2. Click Browse all products.
3. From the All products page, click Software, and then click the required link.
4. Click the required product and then click the required version.

Using search engines, type the name and version of the document in the search box.

Other documents you may need
In addition to this guide, you can access the following guides available at the Dell support site dell.com/support.

.
● System Update User’s Guide
● Systems Management - OpenManage Software Support Matrix
● Update Packages User's Guide
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● Server Update Utility User's Guide
● OpenManage Server Administrator Installation Guide
● OpenManage Essentials User's Guide
● OpenManage Enterprise User's Guide
● OpenManage Integration for VMware vCenter
● OpenManage Integration for Microsoft System Center Version 7.3 for Microsoft Endpoint Configuration Manager and

System Center Virtual Machine Manager
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Identifying the series of your Dell PowerEdge
servers

The PowerEdge series of servers from Dell are divided into different categories based on their configuration. They are referred
as 13th generation PowerEdge servers, 14th generation PowerEdge servers, 15th generation PowerEdge servers, series of
servers. The structure of the naming convention is described below:

The first initial denotes the character in the server model number. The character denotes the form factor of the server. The
form factors are listed below:

● C- Cloud
● F- Flexible
● M or MX- Modular
● R- Rack
● T- Tower

The number denotes multiple characteristics about the server. They are listed as follows:

● The first digit denotes the value stream or class of the server.
○ 1-5—iDRAC basic
○ 6-9—iDRAC Express

● The second digit denotes the series of the server. It is retained in the server naming convention..
○ 0—series 10
○ 1—series 11
○ 2—series 12
○ 3—series 13
○ 4—series 14
○ 5—series 15
○ 6—series 16

● The last digit always denotes the make of the processor as described below:
○ 0-Intel
○ 5-AMD

NOTE: For servers that use an AMD processor, the model number is made up of four digits instead of three. The third digit

denotes the number of processor sockets that the series of server supports.

● 1 ̶̶ one socket server

● 2 ̶̶ two socket server

Table 5. PowerEdge servers naming convention and examples 

PowerEdge 13G Servers PowerEdge 14G Servers PowerEdge 15G Servers PowerEdge 16G Servers

PowerEdge M630 PowerEdge M640 PowerEdge R6515 PowerEdge R660

PowerEdge M830 PowerEdge R440 PowerEdge R7515 PowerEdge C6600

PowerEdge T130 PowerEdge R540 PowerEdge R6525 PowerEdge HS5610

- PowerEdge R6415 PowerEdge R750xa PowerEdge R7625

- PowerEdge R7415 PowerEdge R7525 PowerEdge XR5610

- PowerEdge R7425 PowerEdge XE8545 PowerEdge XE8640

11

Identifying the series of your Dell PowerEdge servers 45



Command-line interface syntax
The following chapter describes the syntax for the commands that you can use in command-line interface(CLI) mode:

Consider the following points for using DRM through CLI:
● The CLI mode works in interactive mode and prompt for a password, when the password is not given in the command.
● It is recommended to use only supported commands in CLI to perform any DRM operation. However, any partial or

incomplete commands are not supported.
● For Linux users only, ensure that you have read and write access to the drmuser account in the particular directory

including all subdirectories. This access is required to export, import, or download a repository, add a catalog, update a
plug-in, or configure the storage location in Dell Repository Manager > Application Preferences.

● For Windows operating system users, ensure you have required access (read or write, list folder contents, so forth) to
the NT AUTHORITY\LOCAL SERVICE account in the directory including all sublevel directories. The access is required
to export, import, or download a repository, add a catalog, update a plug-in, or configure the storage location in Dell
Repository Manager > Application Preferences.

● When you perform any operations on a repository, if the repository version is not specified, the operations are performed on
the latest version of the repository.

● To update, delete, or import a specific repository use the repository name with version in the following format:
<repository name>:<repository version>.

● For running any DRM operations, ensure that you provide the recurring read and write access to local share folders in the
Linux operating system. For example, the create repository, import and export operations require the read and write access
for the local share folders.

● Run all the commands on the Windows operating system using / or - character.

● To use a network path, provide the authentication attribute in the following format: --
authentication="domain\username:password". For OMIVV console, provide username@domain:password.

● All the CLI operations are limited to a single repository.
● The selection of bundles is not supported in CLI.
● For DRM v3.4.4 or later, the exported share catalog name is <reponame>_catalog.xml.

● To export the deployment tools with date and time:
○ Allows only one export job with the same repository and the same deployment type.
○ Delete an existing export job if you want to use the same repository and same deployment type.
○ Editing of an export job is enabled for frequency (daily, monthly, or weekly) and time.
○ The recurring schedule of an export job overwrites existing content on the same target location.

● The scheduled export job runs against the latest version of the repository only.
● Nowait attribute can be used with export, scheduled refresh, and plug-in update.
● If the source and catalog attributes are not used for repository creation, then the latest Enterprise catalog is considered as

base catalog.
● If you have defined the port number for the integration type, ensure that you specify the port number while creating a

repository.

Table 6. Commands 

Description Command Full form Example

Launching DRM

Open DRM application in a Graphical
User Interface (GUI) mode.

drm N/A drm

Update Password

Update the DRM database password.
NOTE: DRM database password
must contain a minimum of eight
characters with a combination of

N/A drm --update-
password --old-
password="<old
password>" --new-
password="<new
password>"

drm --update-
password --
old-
password="drM
my3@db" --
new-

A
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Table 6. Commands (continued)

Description Command Full form Example

one uppercase, one lowercase,
and one numeric character.

NOTE: The use of special
characters in database password
is not compulsory.

--confirm-
password="<confirm
password>"

password="db4
Drm_pw" --
confirm-
password="db4
Drm_pw"

Commands to display details in DRM

Display the current version of DRM. drm -v drm --version drm --version
Display a help menu. drm -h drm --help drm --help
Display the list of all repository
names, latest version, size, and the
latest date when it was modified.

drm -li=rep drm --list=rep drm --
list=rep

Display all console integration types. drm -li=integration-type drm --list=
integration-type

drm --list=
integration-
type

Display the list of groups for the
following console integration types:
● OpenManage Integration for

Microsoft System Center
(OMIMSSC)

● OpenManage Enterprise console
(OMENT)

drm --list=groups
-ih=<ip> -it=<type> --
authentication=<username:
password>

drm --list=groups --
integration-host=IP
address --
integration-
type=oment --
authentication=<user
:password>

drm --
list=groups
--
integration-
host=IP
address --
integration-
type=oment --
authenticatio
n=<user:passw
ord>

Displays all available categories drm -li=category drm --list=category drm
-li=category

Displays all the categories for a
specific repository version

drm -li=category
-r=<repository
name>:<version>

drm --list=category
--
repository=<reposito
ry name>:<version>

drm
-li=category
-r=repo1:1.01

Displays all available catalogs drm -li=catalogs drm --list=catalogs drm
-li=catalogs

Displays all available component types drm -li=component-types drm --
list=component-types

drm --
list=componen
t-types

Displays all the component types for
a specific repository

drm -li=component-type
-r=<repository name>

drm --
list=component-type
--
repository=<reposito
ry name>

drm
-li=component
-type
-r=repo1

Display bundles and component
details of a specific version of the
repository.

drm --details
-r=<repository
name>:<version>

drm --details --
repository=<reposito
ry name>:<version>

drm --details
-r=repo1:1.01

Compare a version of the repository
with the base catalog in the
database.

drm --compare -
r=<repository
name>:<version>

drm --compare --
repository=<reposito
ry name>:<version>

drm --
compare --
repository=re
po1:1.1
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Table 6. Commands (continued)

Description Command Full form Example

Display the list of all plug-in
names, current-version, and the
latest available version.

drm -li=plugin drm --list=plugin drm
-li=plugin

Display all the versions that are
associated with the repository such
as version, size, and created date.

drm -r=<repository name>
--details

drm --
repository=<reposito
ry name> --details

drm -r=repo1
--details

Display the list of all job names,
status, type, and creation date.

drm -li=job drm --list=job drm --
list=job

Display details of a specific job. drm -j=<job name> --
details

drm --job=<job  
name> --details

drm
-j=samplejob
--details

Preferences

To set proxy details. With authentication

drm --set -p=http://
username:password@proxy-
server:port

With authentication

drm --set --
proxy=http://
username:password@pr
oxy-server:port

drm --set
-p=http://
root:calvin@1
00.10.20.16:8
080

Without authentication

drm --set -p=http://
proxy-server:port

Without authentication

drm --
set --proxy=http://
proxy-server:port

drm --set
-p=http://
100.10.20.16:
8080

Set a custom store path for
downloading files.

NOTE: Ensure that you change
the store path location when no
jobs are running.

drm --set -sp=<path> drm --set --
storepath=<path>

drm --set
-sp="C:\Users
\DRM\download
s"

To set the plug-in update to an
autoupdate.

drm --set -pu=autoupdate drm --set --
pluginupdate=autoupd
ate

drm --set
-pu=autoupdat
e

To set the plug-in update to alert drm --set -pu=alert drm --set --
pluginupdate=alert>

drm --set
-pu=alert

Update a plug-in or all plug-ins. drm --update --
plugin=<plug-in name|
all>

drm --update --
plugin=<plug-in
name| all>

drm --
update --
plugin=
"Dell System
Update(BIN)"

Update a catalog or all catalogs. drm --update --
catalog=<catalog id |
all>

drm --update --
catalog=<catalog id
| all>

drm --update
--
catalog=637e0
d3f-
f41e-4799-
b595-3f182f3d
9cae

Delete a catalog.
NOTE: Deletion of default
catalogs is not supported.

drm --delete --
catalog=<catalog id>

drm --delete --
catalog=<catalog id>

drm --delete
--catalog=
9baaff3c-34f3
-4dd7-
a46d-22b5be35
7a5e

Clean up the store path. drm --cleanup drm --cleanup drm --cleanup
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Table 6. Commands (continued)

Description Command Full form Example

Create repositories

Create an empty repository. drm -cr -r=<repository
name> --empty

drm --create --
repository=<reposito
ry name> --empty

drm -cr
-r=repo1 --
empty

Create an integration repository for
a specific console group of the
following:
● OpenManage Integration for

Microsoft System Center
(OMIMSSC)

● OpenManage Enterprise console
(OMENT)

drm -cr -r=<repository
name> -ih=<ip address|
hostname| FQDN>
-it=<intergration type>
--groups=<group names> --
authentication=<domain\us
ername>:<password>

drm -create --
r=<repository name>
---integration-
host=<ip address|
hostname| FQDN>
-it=<intergration
type> --
groups=<group names>
--
authentication=<doma
in\username>:<passwo
rd>

drm -cr
-r=<repositor
y name>
-ih=<ip
address|
hostname|
FQDN>
-it=oment --
groups=<group
names> --
authenticatio
n=<domain\use
rname>:<passw
ord>

Create a repository with inventory.
NOTE: Source and
authentication attributes are
optional.

drm -cr -r=<repository
name> -i=<inventory file
location> --
source=<catalogFileLocati
on> --
authentication=<domain\us
ername:password>

drm --create --
repository=<reposito
ry name> --
inventory=<inventory
file location> --
source=<catalogFileL
ocation> --
authentication=<doma
in\username:password
>

drm -cr
-r=repo1
-i="C:\Users\
DRM\sample.xm
l"   --
source=//
100.100.10.11
/
DRM\source.xm
l --
authenticatio
n="root:calvi
n"

Create a repository from the default
base catalog by connecting to an
iDRAC console.

drm -cr -r=<repository
name> -ih=<ip address|
hostname| FQDN> -it=idrac
--
authentication=<domain\us
ername>:<password>

drm --create --
repository=<reposito
ry name> --
integration-host=<ip
address| hostname|
FQDN> --integration-
type=idrac --
authentication=<doma
in\username>:<passwo
rd>

drm --create
--
repository=re
po1 --
integration-
host=100.10.1
0.15 --
integration-
type=idrac --
authenticatio
n="mydomain\r
oot:calvin"

Create a repository from the default
base catalog by connecting to an
OpenManage Enterprise (OMENT)
console.

drm -cr -r=<repository
name> -ih=<ip address|
hostname| FQDN> -it=oment
--
authentication=<domain\us
ername>:<password>

drm --create --
repository=<reposito
ry name> --
integration-host=<ip
address| hostname|
FQDN> --integration-
type=oment --
authentication=<doma
in\username>:<passwo
rd>

drm --create
--
repository=re
po1 --
integration-
host=100.10.1
0.15 --
integration-
type=oment --
authenticatio
n=root:omenca
lvin
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Table 6. Commands (continued)

Description Command Full form Example

Create a repository from the default
base catalog by connecting to an
OpenManage Essentials console.

drm -cr -r=<repository
name> -ih=<ip address|
hostname| FQDN> -it=omess
--
authentication=<domain\us
ername>:<password>

drm --create --
repository=<reposito
ry name> --
integration-host=<ip
address| hostname|
FQDN> --integration-
type=omess --
authentication=<doma
in\username>:<passwo
rd>

drm --create
--
repository=re
po1 --
integration-
host=100.10.1
0.15 --
integration-
type=omess --
authenticatio
n="mydomain\r
oot:calvin"

Create a repository from the default
base catalog by connecting to an
OpenManage Integration for VMware
VCenter (OMIVV) console.

drm -cr -r=<repository
name> -ih=<appliance ip
address>;<vCenter ip
address> -it=vcenter --
authentication=<username@
domain:password>

drm --create --
repository=<reposito
ry name> --
integration-
host=<appliance ip
address>;<vCenter ip
address> --
integration-
type=vcenter --
authentication=usern
ame@domain:password

drm -cr
-r=repo1
-ih=100.10.10
.15;100.100.1
5.76
-it=vcenter
--
authenticatio
n=root@mydoma
in:calvin

Create a repository from the
default base catalog by connecting
to an OpenManage Integration
for Microsoft System Center
(OMIMSSC) console.

drm -cr -r=<repository
name> -ih=<ip address|
hostname| FQDN>
-it=omimssc --
authentication=<domain\us
ername:password>

drm --create --
repository=<reposito
ry name> --
integration-host=<ip
address| hostname|
FQDN> --integration-
type=omimssc --
authentication=<doma
in\username:password
>

drm --create
--
repository=re
po1 --
integration-
host=100.10.1
0.15:8080 --
integration-
type=omimssc
--
authenticatio
n=root:calvin

Create a repository from the default
base catalog by connecting to a
console.

drm -cr -r=<repository
name> -ih=<url>
-it=console --
authentication=<domain\us
ername:password>

drm --create --
repository=<reposito
ry name> --
integration-
host=<url> --
integration-
type=console --
authentication=<doma
in\username:password
>

drm --create
--
repository=re
po1 --
integration-
host=https://
100.10.10.15:
8080/
genericconsol
erepository
--
integration-
type=console
--
authenticatio
n=root:calvin

Create a repository from a custom
catalog in the local path.

drm -cr -r=<repository
name> -ih=<ip:port |
hostname> -it=<type> --
source=<catalog file
location>

drm --create --
repository=<reposito
ry name> --
integration-
host=<ip:port |
hostname> --
integration-

drm --create
--
repository=re
po
-integration-
host=100.10.1
5.11 --
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Table 6. Commands (continued)

Description Command Full form Example

type=<type> --
source=<catalog file
location>

integration-
type=idrac --
source="C:\Us
ers\DRM\sampl
e.xml"

Create an integration repository by
using the custom catalog from a
network path.

NOTE: Ensure that you use the
authentication attributes after
specifying the integration host
and source attributes.

drm -cr -r=<repository
name> -ih=<ip> --
authentication=<domain\us
ername:password>
-it=<type> --
source=<catalog path> --
authentication=<domain\us
ername:password>

drm --create --
repository=<reposito
ry name> --
integration-
host=<ip> --
integration-
type=<type> --
source=<catalog
path> --
authentication=<doma
in\username:password
>

drm -cr
-r=repo1
-ih=100.100.1
5.76 --
authenticatio
n=root:calvin
-it=idrac --
source=//
100.60.50.55/
DRM/
catalog.xml
--
authenticatio
n=root1:calvi
n

Create a manual repository. Optional
attributes:
● inputplatformlist
● dupformat

drm -cr -r=<repository
name>
or

drm -cr -r=<repository
name> --
inputplatformlist=<Platfo
rmA,PlatformB, ....> --
dupformat=<dupformatA,dup
formatB, ...> --
source=<source repository
path>

drm --create --
repository=<reposito
ry name> --
inputplatformlist=<P
latformA,PlatformB, 
....> --
dupformat=<dupformat
A,dupformatB, ...> -
-source=<catalogFile
Location>

drm -cr
-r=repo1 --
inputplatform
list=R740 --
dupformat=win
64,linux,
osind

Create a repository for index catalog
using catalog id.

drm -cr -r=<repository
name> -ih=<ip> -it=<type>
--catalog=<catalog id>

drm --create --
repository=<reposito
ry name>
-integration-
host=<ip> --
integration-
type=<type> --
catalog=<catalog id>

drm --create
--
repository=re
po --
integration-
host=100.10.1
5.55 --
integration-
type=idrac --
catalog=74b69
121-2e85-46be
-a6d7-7f69728
dac23

Create Deployment tools

Export a repository as Catalog Only. drm --deployment-
type=exportCatalog
--location=<path>
-r=<repository name>

drm --deployment-
type= exportCatalog
--location=<path> --
repository=<reposito
ry name>

drm --
deployment-
type=
exportCatalog
--
location="C:\
Users\DRM" --
repository=re
po

Export full repository with DUPs and
catalog.

drm --deployment-
type=share --

drm --deployment-
type=share --

drm
--deployment-
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Table 6. Commands (continued)

Description Command Full form Example

location=<path>
-r=<repository name>

location=<path> --
repository=<reposito
ry name>

type=share --
location="C:
\Users\DRM"
-r=repo

Export Smart Deployment Scripts to
a location.

Optional attributes:

force-update

drm -r=<repository
name> --deployment-
type=smartscript --
script-type=<OS type> --
location=<path> --force-
update --nowait

drm --
repository=<reposito
ry name> --
deployment-
type=smartscript --
script-type=<OS
type> --
location=<path> --
force-update --
nowait

drm -r=repo1
--deployment-
type=smartscr
ipt --script-
type=linux --
location="C:\
Users\DRM" --
force-update
--nowait

Export Smart Deployment Scripts
using prescript and postscripts to a
location.

Optional attributes:

● Prescript
● Postscript

NOTE: Ensure that prescript
and postscript are in the same
network location.

drm -r=<repository name>
--deployment-
type=smartscript --
script-type=<OS type> --
prescript=<script path>
--script-
authentication=<username:
password> --
postscript=<script path>
--script-
authentication=<username:
password> --
location=<path> --nowait

drm --
repository=<reposito
ry name> --
deployment-
type=smartscript --
script-type=<OS
type> --
prescript=<script
path> --script-
authentication=<user
name:password> --
postscript=<script
path> --script-
authentication=<user
name:password> --
location=<path> --
nowait

drm -r=repo1
--deployment-
type=smartscr
ipt --script-
type=linux --
prescript=//
100.18.6.22/
DRM/
prescript.sh
--script-
authenticatio
n=root:calvin
--
postscript=//
100.18.6.22/
DRM/
postscript.sh
--location=//
100.88.33.34/
DRM --
authenticatio
n=root:calvin
--nowait

Export Smart Deployment Script
using custom script to a location.

NOTE: If you are using the
update-script attribute, you
cannot use the prescript,
postscript, or force-update
attributes.

drm -r=<repository
name> --deployment-
type=smartscript --
script-type=<OS type>
--update-script=<custom
script path> --
location=<path> --nowait

drm --
repository=<reposito
ry name> --
deployment-
type=smartscript ---
script-type=<OS
type> --update-
script=<custom
script path> --
location=<path> --
nowait

drm -r=repo1
--
deployment-
type=smartscr
ipt --script-
type=windows
--update-
script="C:\Us
ers\DRM\custo
mscript.bat"
--
location="C:\
Users\DRM" --
nowait

Export Smart Bootable ISO with
Force Update option to a local path.

drm -r=<repository
name> --deployment-
type=smartbootiso --
location=<path> --force-
update --nowait

drm --
repository=<reposito
ry name> --
deployment-
type=smartbootiso --
location=<path> --

drm -r=repo1
--deployment-
type=smartboo
tiso --
location="C:\
Users\DRM" --
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Table 6. Commands (continued)

Description Command Full form Example

force-update --
nowait

force-update
--nowait

Export Smart Bootable ISO using
default script.

drm -r=<repository
name> --deployment-
type=smartbootiso --
location=<folderpath>

drm --
repository=<reposito
ry name> --
deployment-
type=smartbootiso --
location=<folderpath
>

drm -r=repo1
--deployment-
type=smartboo
tiso --
location="C:\
Users\DRM"

Export Smart Bootable ISO using
custom script from a network path.

drm -r=<repository name>
--deployment-
type=smartbootiso --
location=<path> --
authentication=<username:
password> --update-
script=<custom-script-
path> --script-
authentication=<username:
password>

drm --
repository=<reposito
ry name> --
deployment-
type=smartbootiso --
location=<path> --
authentication=<user
name:password> --
update-
script=<custom-
script-path> --
script-
authentication=<user
name:password>

drm -r=repo1
--deployment-
type=smartboo
tiso --
location=//
100.10.90.22/
DRM" --
authenticatio
n=root:calvin
--update-
script=//
100.18.90.55/
DRM/
samplescript.
sh" --script
--
authenticatio
n=root:calvin

Export SUU ISO to a location. drm -r=<repository name>
--deployment-type=suuiso
--location=<path> --
nowait

drm --
repository=<reponame
> --deployment-
type=suuiso --
location=<path> --
nowait

drm -r=repo1
--deployment-
type=suuiso
--
location="C:
\Users\DRM"
--nowait

Export SUU in directory form to a
location.

drm -r=<repository
name> --deployment-
type=suuiso --expand-
iso --location=<path> --
nowait

drm --
repository=<reposito
ry name> --
deployment-
type=suuiso --
expand-iso --
location=<path> --
nowait

drm
-r=<repositor
y name> --
deployment-
type=suuiso
--expand-iso
--location=//
100.90.55.23/
drm --
authenticatio
n=root:calvin
--nowait

Export the deployment tools with
a specific date and time with
recurrence as daily, weekly, or
monthly.

drm --deployment-
type=share --
location=<path>
-r=<repository name> --
datetime= <mm/dd/yyyy
hh::mm> <recurrence> --
nowait

drm --deployment-
type=share --
location=<path>
-r=<repository name>
--datetime= <mm/dd/
yyyy hh::mm>
<recurrence> --
nowait

drm --
deployment-
type=share --
location=D:\P
GT2V -r=Repo
--
datetime="06/
02/2023 22:56
daily" --
nowait
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Command line interface
The following chapter describes the mandatory and optional attributes for the commands that you can use in command line
interface(CLI) mode:

Importing components
Table 7. Commands for importing components 

Description Mandatory Optional Format and example

Import specific components
to a repository from a
source location using wildcard
characters.

--import If you are using
external network share: --
authentication

Format: drm --
import -r=<repository
name> --update-
package=<components>
--ignore-sign-
verification --
source=<dups folder>

--repository
or

-r

--ignore-sign-
verification

Example: drm --
import -r=repo1
--update-package=
BIOS*,*.EX?,*.BIN
--source="C:
\Users\DRM\DUPS"
--ignore-sign-
verification

--repository
or

-r

--update-package
--source

Import all supported
components from a source
location.

--import If you are using
external network share: --
authentication

Format: drm --import
-r=<repository name>
--source=<network
path> --
authentication=<usern
ame:password>

--repository
or

-r

--ignore-sign-
verification

Example: drm --import
-r=repo1 --source=//
100.100.18.15/test/
DUPS --
authentication=root:c
alvin--source

Updating repositories
Table 8. Commands for updating repositories 

Description Mandatory Optional Format and example

Run a refresh job. --update --repository:version Format: drm --
update -r=<repository
name>:<version>

B
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Table 8. Commands for updating repositories (continued)

Description Mandatory Optional Format and example

--repository
or

-r

Example: drm --update
-r=repo1

Schedule a refresh repository
job.

The values for the Recurrence
option are:

● Once
● Daily
● Weekly
● Monthly

NOTE: Ensure that you
enter the time in a 24-
hour format.

--update --repository:version Format: drm --
update -r=<repository
name>:<version>
-dt=<mm/dd/yyyy
hh:mm> <recurrence>
--nowait

--repository
or

-r

Example: drm --
update -r=repo1
-dt="08/21/2019 12:00
Daily" --nowait

--datetime
or

-dt

--nowait

Update components in a
repository by component
type.

--update --repository:version Format: drm --update
-co=<component type>
-r=<repository name>

--component-type
or

-co

Example: drm --update
-co="BIOS,application
" -r="repo:1.00"

--repository
or

-r

Update components in a
repository by category.

--update --repository:version Format: drm --update
-ca=<category1,
category2,.....
> -r=<repository
name>:<version>

--category
or

-ca

Example: drm --update
-ca="BIOS, SAS Drive"
--
repository="repo:1.00
"

--repository
or

-r

Update a repository based on
the type of change.

--repository
or

-r

--repository:version Format: drm
-r=<repository name>
--update -ct=<type>

--update Example: drm
-r=repo1 --update
-ct="upgraded"--changetype

or

-ct
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Table 8. Commands for updating repositories (continued)

Description Mandatory Optional Format and example

Update a repository based on
criticality of updates.

--repository
or

-r

--repository:version Format: drm
-r=<repository
name> --update
-cc=<criticailty
type1, criticality
type2,.....>

--update Example: drm -r=repo1
--update -cc="urgent,
recommended"--criticality

or

-cc

Edit repositories or jobs
Table 9. Commands for editing repository name 

Description Mandatory Optional Format and example

Edit the name of a repository. -e N/A drm -r=<repository
name> -e= <new name>

--repository
or

-r

Example: drm --
repository=repo -e=repo1

Edit an export job with a
specific date and time.

drm --job=<job
name> -e --
datetime="<mm/dd/yyyy
hh::mm> <recurrence>"

N/A drm --
job=Export_05/31/2023
_04:26:18 -e --
datetime="10/04/2024
9:45 weekly"

Deleting components, repositories or jobs
Table 10. Commands for deleting components and repositories 

Description Mandatory Optional Format and example

Delete a repository by
repository name.

--delete
or

-d

--repository:version Format: drm -d
-r=<repository name>

--repository
or

-r

Example: drm -d -r=repo1

Delete components in a
repository by category.

--delete
or

-d

--repository:version Format: drm -d
-r=<repository name>
-ca=<category name>

--repository
or

-r
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Table 10. Commands for deleting components and repositories (continued)

Description Mandatory Optional Format and example

--category
or

-ca

Example: drm -d -r=repo1
-ca="SAS Drive ,SAS Non-
RAID, Tape Drives"

Delete components by
component type.

--delete
or

-d

--repository:version Format: drm -d
-r=<repository name>
-co=<component type>

--repository
or

-r

--component-type
or

-co

Example: drm -d -r=repo1
-co="BIOS, Firmware"

Delete components by
criticality.

--delete
or

-d

--repository:version Format: drm -d
-r=<repository name>
-cc=<criticality>

--repository
or

-r

--criticality
or

-cc

Example: drm -d -r=repo
-cc=urgent,optional

Delete specific components
from a repository using
wildcard characters.

--delete
or

-d

--repository:version Format: drm
-d -r=<repository
name> --update-
package=<component
name>

--repository
or

-r

--update-package Example: drm -d
-r=repo1 --update-
package="network*.exe
,BIOS_0KT74_LN_2.10.5
.BIN"

Delete components using a
combination of attributes.

--delete
or

-d

--repository:version Format: drm -d
-r=<repository name>
-co=<component type>
-cc=<criticality>
-ca=<category>

--repository
or

-r

Example: drm --delete
-r=R740:1.00
-cc=urgent,recommende
d
-co=BIOS,application
-ca=BIOS,Diagnostics--component-type
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Table 10. Commands for deleting components and repositories (continued)

Description Mandatory Optional Format and example

or

-co

--criticality
or

-cc

--category
or

-ca

Delete a job.
NOTE: Deleting a running
or scheduled export job
deletes the created job
from the Jobs page.

drm --delete --
job=<job name>

N/A drm --delete --
job=Export_05/31/2023
_04:26:18

Logs
Table 11. Commands for viewing logs 

Description Mandatory Optional Format and example

Download the log file. --logfile N/A Format: drm --
logfile=<specify path to
dowload the file>

Example: drm --
logfile=export/mylog.zip
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Frequently asked questions
This section lists some frequently asked questions about DRM.

Why is DRM not recognized?
After installing DRM on the Microsoft Windows operating system, when you try to run any DRM commands through CLI,
the following error message is displayed: drm is not recognized as an internal or external command,
operable program or batch file.
Run the DRM remove file DRM_Remove.bat from location C:\Program Files\Dell\Dell Repository
Manager\DRM_Remove.bat.

Then rerun the DRM service file DRM_Service.bat as an Administrator from the installer location. Example of an installer
location: C:\Program Files\Dell\Dell Repository Manager\DRM_Service.bat

NOTE: If the resolution does not work, then go to the installed DRM location and run the DRM commands through CLI.

Why am I not able to run a smart script job from CLI?
When you schedule a smart script job with any path set as a network path, an authentication error message is displayed.

When providing the location of the script, ensure that there is no tailing slash (\) at the end of the path.

Why am I unable to delete a component from a repository
using DRM commands through CLI?
When you add more than one component in a command separating them with a comma, and if you have provided a space after
the comma, the component mentioned after the comma is ignored.

Remove the space before mentioning the component name, and then run the delete operation.

Accessing DRM is taking longer time when too many
catalogs are imported?
When there are more catalogs that are added to a repository, the performance of DRM is impacted.

It is recommended to add a maximum number of 10 catalogs and delete catalogs that are not in use.

How to delete DRM database?
Stop the DRM services, and then delete the following folders:

● For Windows: C:\ProgramData\Dell\drm\database
● For Linux: /var/dell/drm/log/database

NOTE: If you have administrative privileges, ensure that you unhide all the hidden folders in the Microsoft Windows

operating system.

C
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Where is the Dell Repository Manager runtime log located?
DRM creates the log file at runtime in the following location:

You can save or email the logs through Save and Mail Logs option in the Dell Repository Manager drop-down menu.

● Windows: C:\ProgramData\Dell\drm
● Linux: /var/dell/drm/log

Can DRM be run through a Proxy Server?
Yes, install DRM inside the firewall and connect to a catalog located outside the firewall (downloads.dell.com or a local
repository) through a proxy server. You can and then use Dell Repository Manager to customize the catalog as per the
requirement and store the customized catalog inside the firewall. For more information about setting proxy, see Configuring
network settings.

NOTE: If proxy server credentials are changed, ensure that you change the proxy credentials in DRM as well.

Why am I seeing 0-1, 0-2, and so on, in the hours selection
drop-down menu?
In the refresh repository window, if you click the down arrow key when the time is displayed as 00:00, it changes to 0-1. After
clicking it again, it turns to 0-2 and so on.

Use the up arrow key to set the hour value.

How do I edit the ‘.sh’ file in the Linux deployment script
bundle? Is there any recommended tool to edit this file?
Notepad++ editor is recommended for editing the Linux-based file extension on a Microsoft Windows operating system. If you
want to edit the extension of the file on a Linux operating system, vi editor is recommended.

I am facing access denying issues in the Linux operating
system. How do I proceed further?
Ensure that you have Read and Write access to the drmuser account in the particular directory including all sublevel
directories and files when you want to export, import, or download a repository, add a catalog, update a plug-in, or configure the
storage location in Application Preferences.

I saved a file in the mapped network location. However, I
am not able to access the location from DRM. What do I do
now?
Ensure that you have privileges to access the location and then login with the appropriate credentials.
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I am not able to automatically discover the Microsoft
Exchange Web Service URL when trying to configure the
email notifications. Is there any other option to discover the
URL apart from updating it manually?
From DRM version 3.0 onwards, the autodiscovery of Microsoft Exchange Web Server URL is not supported. Update the URL
manually.

I am not able to create a repository or an inventory
repository using a specific catalog and inventory file through
command-line interface. How do I proceed?
Ensure that the catalog and inventory are available in the same network location and then create a repository.

Where can I change the DUP sequence order in DRM
version 3.x before exporting to a deployment format?
You can no longer customize the sequence to install DUPs. Start from DRM version 3.0, the smart deployment feature now run
DSU at install time on a server configuration to determine the proper order to install the DUPs. DRM ensures that iDRAC is the
last update to run, and the sequence for rest of the DUPs is taken care by DSU.

I am not able to install DRM in a custom location on
the Linux operating system. How do I proceed with the
installation?
Use the default path only for installing DRM because the custom location is not supported. By default, the installer location is
set to /opt/dell.

After I delete a bundle, it is not deleted from the bundle list
on the GUI. Should I delete it elsewhere so that it is updated
on the GUI?
If the size of a bundle or a collection of bundles that are selected to be deleted exceeds 1 GB, several minutes may be required
to delete and reflect the progress on the GUI. The workaround is to wait for sometime for the GUI to reflect the change or exit
from the DRM console and reopen the DRM application.

I have installed the latest version of DRM on my system,
and I am trying to downgrade to one of the previous
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versions. However, I am not able to proceed further. What
do I do now?
Reverting to the previous version of DRM is not supported in the current version of the DRM installer . To install an earlier
version of DRM, manually uninstall the latest version and then run the installer of the required version.

NOTE: DRM version 2.0 and DRM version 3.x.x can co-exist on the same system.

Why the import of plugins is unsuccessful?
When you import plugins from the exported repository using Smart Deployment Script deployment job, the plugins are not
imported because the corresponding sign files are not available.

Manually download the plug-in and sign files from the support site and have them in the same location.

Why am I not able to upgrade or reinstall DRM?
When a few files inside the install path: C:\Program Files\Dell\Dell Repository Manager are removed or deleted
without following a proper uninstallation process and you try to upgrade DRM, you get the following error message: One or
more newer versions of the product are already installed. An upgrade is not applicable.
To upgrade DRM:

● For the Windows operating system—Delete the product element that is named Dell Repository Manager present in
the .com.zerog.registry file in C:\Program Files\Zero G Registry folder and then reinstall DRM.

● For the Linux operating system—Delete the product element that is named Dell Repository Manager present in
the .com.zerog.registry file in \var folder and then reinstall DRM.

To resolve any DRM-related issues, it is recommended to use Repair option after launching the DRM install window instead of
the Uninstall option.

NOTE: Ensure that you view all the hidden items because Zero G Registry is a hidden folder.

For example, when you search for Dell Repository Manager, the following product element is
found: <product name="Dell Repository Manager" id="da88caaa-1f2c-11b2-862b-b8c367dd4f00"
upgrade_id="5addbe2f-1f41-11b2-91ce-954f877e94a0" version="3.3.0.627" copyright="2019"
info_url="" support_url="" location="C:\Program Files\Dell\Dell Repository Manager"
last_modified="2019-12-27 18:07:23">. Delete the entire product element, and then save the file.

Why OLH does not work in DRM, when launched through
CLI on the Linux operating system?
Recommends you to launch DRM through CLI using the same user session as the logged-in user.

Unable to upgrade from DRM v3.3.2 or older versions to the
latest available DRM versions using Virtual private network
(VPN) connection. How do I proceed?
Disconnect from VPN connection and download DRM and then manually install and upgrade.
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Why does the locally imported catalog in DRM delete
automatically when updated to the latest version as Default
Enterprise Server Catalog?
If an imported or updated custom catalog has the same version and identified as Default Enterprise Server Catalog, available in
DRM. Then the custom catalog gets deleted automatically to avoid the identical entries of the catalog.

The generated catalog after import of iDRAC dependency
DUP to an existing repository in DRM fails even after
upgrading to DRM v3.4.1 or later. How to fix this to avoid
failure?
Create a repository in DRM v3.4.1 or later and then import a iDRAC dependency DUP and then export the catalog.

Why does the Repository creation fail when Repository
Name contains some special characters?
Special characters (~, !, @, #, $, ^, &, (, ), _, +, {, }, `, =, -) are not supported for Repository Name during repository creation.

Why does the DRM application not launch in GUI mode
of Ubuntu and SLES using the created shortcut icon after
install or upgrade of DRM to the latest version?
To launch DRM, use one of the following:

● Launch the DRM application using CLI command.

Or

● Copy the created shortcut icon to the Desktop directory of the user. Then, right click the icon, and then select Allow
Launching.

The installation or upgrade of DRM v3.4.0 is unsuccessful
because of failure in lockbox initialization due to change in
unsupported Operating system(OS) language settings.
To install or upgrade, perform either of the following as per the requirement:

Upgrade DRM to the latest version by providing the same database password that was given during DRM v3.4.0 for Database
initialization.

Or

If you are unable to remember the password given during DRM v3.4.0, then perform a fresh installation of DRM by uninstalling
the older versions of DRM with the selected Remove DRM Content, option.
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The Repository created in DRM v 3.3.2 or older versions
using CLI or GUI mode, shows the dependency DUPs and
the latest DUPs in the repository bundles.
Ensure that DRM is upgraded to the latest version 3.4.x and the latest available enterprise catalog has refreshed to create or
refresh repository.

DRM Logs are getting saved in any of the user-defined file
formats such as .rar, or .zip, or .txt in local or network share
location?
Ensure that the DRM logs are downloaded only in .zip format in a local or network share location, irrespective of the available
and downloaded file formats.

Unable to replace the DRM log files if the same file name
already exists using CLI. How do I proceed?
The replacement of the DRM logs option with the same file name is not be supported using CLI.

How can I change the DRM service access privileges
again without losing the existing data or repositories in the
windows operating system for an installed DRM version
3.4.3 or later?
Uninstall the existing or an installed DRM version without removing the content using the CLI mode or GUI mode. Then, reinstall
the DRM application again with the required service access privilege that restores the old content and service access gets
updated.

DRM shows incomplete Plugin update job messages on the
CLI window when all plugins are updated together.
Use the list jobs command to view the plug-in details and status.

A scheduled job continues to be in a scheduled state on the
Jobs page when the system date and time is changed.
The job is scheduled according to the prior set system's date and time. Hence, the job stays in the scheduled state for an
interval of time. After the first set time elapses, the scheduled job will run. Thus, the next instance of a job is scheduled as per
the updated system date and time.

Workaround—To run the job for the new set system's date and time, restart the system to synchronize the service parameters
with the system parameters, or restart the DRM services.
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The latest plug-in versions are unavailable in the DRM
version 3.4.3 or earlier.
To use the latest plug-in versions, it is recommended to upgrade DRM to version 3.4.4 or above. If DRM is not upgraded, then
only earlier versions of plug-in will be available to perform plug-in related operations.
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